
LESS Manual

1

         LESS  User’s  Manual         
Version 2.0

By Jianbo Qi
2022/11/4



LESS Manual

2

Table of Contents

1. Introduction..................................................................................................................................................4
2. Fundamentals of LESS...............................................................................................................................4

2.1 Forward photon tracing (FPT) ....................................................................................................4
2.1.1 Photon tracing.................................................................................................................4
2.1.2 Virtual photon..................................................................................................................6

2.2 Backward path tracing (BPT)......................................................................................................6
2.3 BPT in simulating thermal infrared brightness temperature (BT) ......................................7
2.4 Addition of fluorescence photons...............................................................................................8

2.4.1 FLUSPECT model.............................................................................................................8
2.4.2 RT of fluorescence in the canopy of three-dimensional surface element ..9

3. Installation.................................................................................................................................................. 10
4. Graphic User Interface (GUI)................................................................................................................ 11

4.1 Preview Panel............................................................................................................................... 11
4.2 Parameter Control Panel............................................................................................................ 11

4.2.1 Sensor.............................................................................................................................. 11
4.2.2 Observation ................................................................................................................... 12
4.2.3 Illumination & Atmosphere...................................................................................... 12
4.2.4 Optical Database.......................................................................................................... 13
4.2.5 Terrain.............................................................................................................................. 13
4.2.6 Objects ............................................................................................................................ 13

4.3 Progress Panel.............................................................................................................................. 15
4.4 Menu Panel ................................................................................................................................... 15

4.4.1 File menu........................................................................................................................ 15
4.4.2 Run menu....................................................................................................................... 15
4.4.3 Tools menu .................................................................................................................... 15
4.4.4 Display menu ................................................................................................................ 15
4.4.5 Process menu................................................................................................................ 15
4.4.6 Help menu ..................................................................................................................... 15

5. Practical tutorial ....................................................................................................................................... 16
5.1 Major functionalities .................................................................................................................. 16

5.1.1 FPAR simulations ......................................................................................................... 16
5.1.2 LiDAR simulations........................................................................................................ 17
5.1.3 Simulations of Multi-Spectral Image .................................................................... 22
5.1.4 Fisheye camera simulation ....................................................................................... 27
5.1.5 Simulation of Multi-angle Reflectance................................................................. 28
5.1.6 Directional Gap Fraction simulation.................................................................... 32
5.1.7 Thermal Infrared Image Simulation .................................................................... 33
5.1.8 Sun Induced Chlorophyll Fluorescence Simulation ........................................ 34
5.1.9 Layered Illumination/Shaded Leaf Area Ratio*............................................... 35
5.1.10 TRAC simulation* ...................................................................................................... 39
5.1.11 Fisheye image transmittance simulation*........................................................... 39
5.1.12 Light simulation* ........................................................................................................ 40



LESS Manual

3

5.1.13 Re-collision probability simulation ....................................................................... 41
5.1.14 Cloudy medium expressed leaf ............................................................................... 42

5.2 Utility ............................................................................................................................................. 43
5.2.1 LAI calculation tool...................................................................................................... 43
5.2.2 Batch processing tool................................................................................................. 44
5.2.3 Image and LiDAR waveform viewer ...................................................................... 44
5.2.4 Simple crown generation tool................................................................................. 45
5.2.5 Reconstruction of 3D scene from airborne point cloud................................. 46
5.2.6 Python code automatic generation tool.............................................................. 47

5.3 LESS file format.......................................................................................................................... 47
5.3.1 instance.txt ..................................................................................................................... 47

5.4 SDK for Python ........................................................................................................................... 48
5.4.1 Implement LESS simulation using SDK for Python........................................... 48
5.4.2 Crown formation.......................................................................................................... 58

6. LESS extension modules ....................................................................................................................... 59
6.1 LESS1D......................................................................................................................................... 59

References........................................................................................................................................................... 63



LESS Manual

4

1. Introduction
Three-dimensional (3D) radiative transfer (RT) modeling of the transport and interaction of 

radiation through earth surfaces is a challenging and difficult task. The difficulties lie in the complexity 
of the landscapes and also in the intensive computational cost of 3D RT simulations. To reduce 
computation time, current models work with schematic landscapes or with small-scale realistic scenes. 
The most accurate and efficient models (known as renderers) are from the computer graphics community, 
but the usages are not straightforward for performing scientific RT simulations. That’s the reason why 
we developed this model.

Basically, LESS employs a forward photon tracing method to simulate bidirectional reflectance 
factor (BRF) or flux-related data (e.g., downwelling radiation) and a backward path tracing method to 
generate sensor images (e.g., fisheye images) or large-scale (e.g. 1 km2) spectral images from visible to 
thermal infrared spectral domain. We also provide a user-friendly graphic user interface (GUI) and a set 
of tools are developed to help construct the landscape and set parameters. LESS has already been 
evaluated with other models in terms of directional BRF and pixel-wise simulated images. It can be used 
as benchmarks for validating physical models or training artificial neural network (ANN) to do parameter 
inversion.

2. Fundamentals of LESS

2.1 Forward photon tracing (FPT)

2.1.1 Photon tracing

Forward photon tracing (FPT) traces photon packets with the power 𝑃𝑃(𝜆𝜆) into the scene from 
light sources. The initial power 𝑃𝑃0(𝜆𝜆) of each packet is determined by the power of light sources 
and the number of generated packets 𝑁𝑁. When generating photon packet in a scene with multiple 
light sources, a light source is randomly chosen according to the importance weight 𝑤𝑤𝑘𝑘, which is 

proportional to the power of each light source, i.e., 𝑤𝑤𝑘𝑘 = 𝐿𝐿𝑘𝑘(𝜆𝜆)
∑ 𝐿𝐿𝑘𝑘(𝜆𝜆)𝐾𝐾
𝑘𝑘=1

 with 𝐿𝐿𝑘𝑘(𝜆𝜆) being the power 

of light source 𝑘𝑘 and 𝐾𝐾 being the number of light sources. This mechanism guarantees that a light 
source with larger power has more sampled photon packets. The initial power of each packet, in 
terms of watt (W), is given as

𝑃𝑃0(𝜆𝜆) = ∑ 𝐿𝐿𝑘𝑘(𝜆𝜆)𝐾𝐾
𝑘𝑘=1

𝑁𝑁
(1)

When a photon packet enters the scene along a path defined by its origin and direction of 
propagation, its intersection with landscape elements is tested for. If an intersection is found, the 
power of this packet will be scaled according to the optical properties of the intersected surface, i.e., 
the reflectance or transmittance. For a packet with 𝑄𝑄 times of scattering before it escapes from the 
scene, the power becomes

𝑃𝑃𝑄𝑄(𝜆𝜆) = 𝑃𝑃0(𝜆𝜆) ∙ ∏ �𝜋𝜋𝜋𝜋(𝑞𝑞,𝜔𝜔𝑖𝑖,𝜔𝜔𝑜𝑜,𝜆𝜆)/𝑝𝑝�𝑄𝑄
𝑞𝑞=1  (2)

where the 𝑓𝑓(𝑞𝑞,𝜔𝜔𝑖𝑖,𝜔𝜔𝑜𝑜,𝜆𝜆)  is the bidirectional scattering distribution function (BSDF) at the 𝑞𝑞th 
intersection point during its trajectory. 𝜔𝜔𝑖𝑖,  and 𝜔𝜔𝑜𝑜  are the incident direction and outgoing 
direction of a photon packet, respectively. Since the scattering law of surfaces in LESS is defined 
as Lambertian, the BSDF is interpreted as bidirectional reflectance distribution function (BRDF) or 
bidirectional transmittance distribution function (BTDF), according to 𝜔𝜔𝑖𝑖,, surface normal 𝜔𝜔𝑛𝑛 and 
𝜔𝜔𝑜𝑜, i.e.,

𝑓𝑓�𝑞𝑞,𝜔𝜔𝑖𝑖,𝜔𝜔𝑜𝑜,𝜆𝜆� = 1
𝜋𝜋
�
𝜌𝜌⊥,𝜆𝜆 ∙ sgn(𝜔𝜔𝑛𝑛 ∙ 𝜔𝜔𝑖𝑖,) + 𝜏𝜏𝜆𝜆 ∙ sgn(−𝜔𝜔𝑛𝑛 ∙ 𝜔𝜔𝑖𝑖,), 𝜔𝜔𝑜𝑜 ∙ 𝜔𝜔𝑛𝑛 ≥ 0
𝜌𝜌⊤,𝜆𝜆 ∙ sgn(−𝜔𝜔𝑛𝑛 ∙ 𝜔𝜔𝑖𝑖,) + 𝜏𝜏𝜆𝜆 ∙ sgn(𝜔𝜔𝑛𝑛 ∙ 𝜔𝜔𝑖𝑖,), 𝜔𝜔𝑜𝑜 ∙ 𝜔𝜔𝑛𝑛 < 0  (3)
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where sgn(𝑥𝑥) = �1, x ≥ 0
0, x < 0; 𝜌𝜌⊥,𝜆𝜆

𝜋𝜋
 and 𝜌𝜌⊤,𝜆𝜆

𝜋𝜋
 are the upper and bottom surface BRDF, respectively; 

𝜏𝜏𝜆𝜆
𝜋𝜋

 is the BTDF. In LESS, the transmittances of the surface from both the upper and the bottom side 

are assumed to be the same; The outgoing direction of a photon packet after scattering is determined 
by randomly sampling the BSDF function. For Lambertian surfaces, the model chooses a random 
direction in the outgoing hemisphere. Since a single photon trajectory can be used to simulate BRF 
for any wavelength by updating the power according to the spectral reflectance/transmittance, we 
have omitted the symbol 𝜆𝜆 in the following equations for simplicity.

A photon packet is collected by the sensor if it exits the scene through the top boundary. Lateral 
boundary effects are considered in order to simulate horizontally infinite scenes with a repetitive 
pattern. As shown in Figure 1, the photon packet which exits from the lateral boundaries will re-
enter the scene from the opposite side with the same photon direction until it escapes through the 
top boundary of the scene. When the scattering order of a packet exceeds a user-defined threshold 
(e.g., 5), the propagation of the packet is randomly stopped according to the “Russian roulette” 
mechanism (Kobayashi and Iwabuchi, 2008), which terminates the trajectory of a packet with a 
probability 𝑝𝑝 (e.g., 5%). If the packet survives, its power will be multiplied by 1

1−𝑝𝑝
.

Figure 1. Forward photon tracing.

The collection of the escaped photon packets is achieved by placing a virtual hemisphere above 
the scene (Govaerts and Verstraete, 1998). As shown in Figure 2, the hemisphere is partitioned into 
𝑁𝑁𝑃𝑃 small surface elements (SE) with equal area 𝛥𝛥𝛥𝛥 = 2𝜋𝜋

𝑁𝑁𝑃𝑃
 by utilizing the partition scheme of a 

disk via the equal area projection, i.e., ∆𝛺𝛺 = 𝛥𝛥𝛥𝛥 . The zenithal zones are partitioned through 
(Beckers and Beckers, 2012):

𝜃𝜃𝑖𝑖 = 𝜃𝜃𝑖𝑖−1 −
2

𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎
sin 𝜃𝜃𝑖𝑖−1

2 �
𝜋𝜋

𝑘𝑘𝑖𝑖−1
, 𝑘𝑘𝑖𝑖 = 𝑘𝑘𝑖𝑖−1 �

𝑟𝑟𝑖𝑖
𝑟𝑟𝑖𝑖−1

�
2
  (4)

Where (𝜃𝜃𝑖𝑖 ,𝜃𝜃𝑖𝑖−1) defines a zenithal zone on the hemisphere with 𝜃𝜃0 = 𝜋𝜋
2
; 𝑘𝑘𝑖𝑖 is the total number of 

SEs inside a zenithal angle 𝜃𝜃𝑖𝑖  with 𝑘𝑘0 = 𝑁𝑁𝑃𝑃 ; 𝑟𝑟𝑖𝑖  is the radius corresponding to 𝜃𝜃𝑖𝑖  with 𝑟𝑟𝑖𝑖 =

2 sin 𝜃𝜃𝑖𝑖
2

 for a unit sphere due to the equal area projection; 𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎 is the aspect ratio of each SE, 

which is approximately enforced to 1. For each zenithal zone, it has 𝑘𝑘𝑖𝑖−1 − 𝑘𝑘𝑖𝑖 SEs with equal area.

Figure 2. Unit hemisphere partition. The hemisphere is projected to horizontal plane as a disk using equal 
area projection. The radius 𝑟𝑟𝑖𝑖 in the disk indicates zenith angle 𝜃𝜃𝑖𝑖 in the hemisphere.

When a photon packet exits the scene, the outgoing SE (solid angle) is determined by the 
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photon direction only, i.e., the hemisphere is placed at an infinite position. The BRF in this SE can 
be estimated with (Govaerts and Verstraete, 1998)

𝑓𝑓𝐵𝐵𝐵𝐵𝐵𝐵𝑖𝑖 = 𝜋𝜋𝑃𝑃𝑖𝑖
𝐴𝐴

∆𝛺𝛺𝑖𝑖∙cos𝜃𝜃𝑖𝑖
𝑐𝑐∙𝑃𝑃𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠

(5)

where 𝑃𝑃𝑖𝑖𝐴𝐴 is the power (watt) of all the captured photons in SE 𝑖𝑖, i.e., 𝑃𝑃𝑖𝑖𝐴𝐴 = ∑ 𝑃𝑃𝑄𝑄𝑃𝑃𝑄𝑄∈∆𝛺𝛺𝑖𝑖 ; ∆𝛺𝛺𝑖𝑖 =
2𝜋𝜋
𝑁𝑁𝑃𝑃

 is the solid angle of each SE; 𝜃𝜃𝑖𝑖𝑐𝑐 is the central zenith angle of solid angle ∆𝛺𝛺𝑖𝑖; 𝑃𝑃𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠 is the 

power of all the direct incident photon packets on a reference plane at the top of the scene, i.e., the 
incident radiation at the top of the scene. Once the power in each SE is determined, the scene albedo 
is computed as

𝜔𝜔𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎 =
∑ 𝑃𝑃𝑖𝑖

𝐴𝐴𝑁𝑁𝑃𝑃
𝑖𝑖=1
𝑃𝑃𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠

  (6)

2.1.2 Virtual photon

The real photon approach (described in section 2.2.1) estimates BRF by using small SEs on the 
sphere. More photon packets are needed to reduce the variance when smaller SEs are used. To solve 
this problem, a virtual photon approach, similar to the virtual direction in DART model (Yin et al., 
2015), secondary ray in Rayspread model (Widlowski et al., 2006) or some “local estimates” 
methods (Antyufeev and Marshak, 1990; Marchuk et al., 1980), is introduced. If a packet is 
intercepted by an object (e.g., a tree) in the scene without complete absorption, the packet will be 
scattered in a direction which is randomly sampled by the BSDF function, and a virtual photon 
packet will be sent to each of the defined virtual directions. The possible scattered energy, in terms 
of intensity (W ∙ sr−1), is calculated as

𝐼𝐼 = 𝑉𝑉 ∙ 𝑃𝑃𝑞𝑞−1 ∙ 𝑓𝑓(𝑞𝑞,𝜔𝜔𝑖𝑖 ,𝜔𝜔𝑣𝑣) ∙ cos < 𝜔𝜔𝑣𝑣,𝜔𝜔𝑛𝑛 > (7)
where 𝑃𝑃𝑞𝑞−1  is the power of the incident photon packet at the 𝑞𝑞th  intersection point along its 
trajectory; 𝜔𝜔𝑣𝑣 is a virtual direction; 𝑉𝑉 is a visibility factor which equals to zero if the a landscape 
element occludes the virtual photon packet, and equals to 1 otherwise. When sending the occlusion 
testing rays, the lateral boundary effect is also considered (Figure 3). The final BRF is then given 
as

𝑓𝑓𝐵𝐵𝐵𝐵𝐵𝐵𝑣𝑣 = 𝜋𝜋𝐼𝐼𝑣𝑣𝐴𝐴

cos𝜃𝜃𝑣𝑣∙𝑃𝑃𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠
 (8)

where 𝐼𝐼𝑣𝑣𝐴𝐴 is the power per unit solid angle (W ∙ sr−1) in virtual direction 𝑣𝑣 and 𝜃𝜃𝑣𝑣 is the zenith 
angle of the virtual direction. An advantage of calculating a directional BRF using virtual photon 
approach is that the BRF is estimated within an infinity small solid angle (Thompson and Goel, 
1998), which is the real directional BRF of a scene.

Figure 3. Virtual photon approach to calculate BRF.

2.2 Backward path tracing (BPT)

Instead of tracing photon packets from light sources, backward path tracing sends rays from 
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sensors into the scene. The ray directions are controlled by sensor configurations (field of view, 
position, orientation, etc.). The main task of this ray-tracing algorithm is to establish a connection, 
which is called “path”, between light sources and sensors and to determine the radiance incident 
onto the sensor. The radiance is estimated for every pixel in the output image. Radiance along 
direction oω can be calculated according to a rendering equation (Kajiya, 1986)

𝐿𝐿𝑜𝑜(𝑞𝑞,𝜔𝜔𝑜𝑜) = 𝐿𝐿𝑒𝑒(𝑞𝑞,𝜔𝜔𝑜𝑜) + ∫ 𝑓𝑓(𝑞𝑞,𝜔𝜔𝑖𝑖 ,𝜔𝜔𝑜𝑜)⬚
4𝜋𝜋 𝐿𝐿𝑖𝑖(𝑞𝑞,𝜔𝜔𝑖𝑖)|cos𝜃𝜃𝑖𝑖|𝑑𝑑𝜔𝜔𝑖𝑖 (9)

where 𝐿𝐿𝑜𝑜(𝑞𝑞,𝜔𝜔𝑜𝑜) is the outgoing radiance from point 𝑞𝑞 along direction 𝜔𝜔𝑜𝑜; 𝑓𝑓(𝑞𝑞,𝜔𝜔𝑖𝑖 ,𝜔𝜔𝑜𝑜) is the BSDF 
of the intersected surface, which determines the outgoing radiance along direction 𝜔𝜔𝑜𝑜  at point 𝑞𝑞 
induced by incoming radiance along direction 𝜔𝜔𝑖𝑖; 𝐿𝐿𝑖𝑖(𝑞𝑞,𝜔𝜔𝑖𝑖) is the incoming radiance; 𝜃𝜃𝑖𝑖 is the angle 
between 𝜔𝜔𝑖𝑖 and the surface normal and 𝐿𝐿𝑒𝑒(𝑞𝑞,𝜔𝜔𝑜𝑜) is an emission term (e.g., thermal emission), which 
is described in detail in section 2.4. The algorithm that solves this equation is illustrated in Figure 4. A 
ray from the sensor intersects the elements in the scene at the point 𝑞𝑞. The outgoing radiance induced by 
the sun (or sky) is then calculated according to the BSDF. To calculate the multiple scattering radiation, 
a new ray is launched from the point 𝑞𝑞 with a direction that randomly samples the BSDF. If this ray 
intersects the scene at another point 𝑞𝑞1, the same procedure is applied to 𝑞𝑞1. The outgoing radiance at 
point 𝑞𝑞1 along the randomly selected direction is the incoming radiance of 𝑞𝑞 along direction 𝜔𝜔1. The 
multiple scattering procedure is performed recursively until reaching the maximum scattering order (e.g., 
5) specified by the user. To prevent energy loss due to the termination of scattering, the random cut-off 
technique (“Russian roulette”) used in FPT is also applied to the sensor ray.

When simulating a horizontally infinite scene, the lateral boundary effect is considered for both the 
sensor ray and the illumination ray. At each intersected point (𝑞𝑞𝑖𝑖), an illumination ray, which is built by 
randomly sampling a point 𝑞𝑞𝑒𝑒 on the emitter, is sent towards the emitter. If this ray traverses the lateral 
boundary of the scene, it is also reintroduced into the scene to test whether the intersected point is 
occluded by other landscape elements or not.

Figure 4. Backward path tracing.

2.3 BPT in simulating thermal infrared brightness temperature (BT)

When simulating thermal infrared radiation, the object itself, instead of the sun, becomes an 
“emitter”, which emits thermal radiation according to Planck's law and its emissivity. Since the incident 
energy of the sun in thermal infrared bands (e.g., 10 mµ ) is too weak, we ignore this part of energy in 
our simulation. However, the presence of sun radiation will greatly influence the temperature distribution 
of objects due to the shadows cast between them. This generally classifies the scene elements into four 
components with specific temperatures, i.e., sunlit soil, shaded soil, sunlit leaves and shaded leaves 
(Figure 5). The determination of these four components is computed on the fly instead of a precomputing 
step adopted by most of other forward models (e.g., DART). This on-the-fly approach avoids the storage 
of emission points, which can greatly reduce the memory usage, especially for scenes with a large number 
of leaves. 

If a sensor ray is intersected in the scene (i.e., 𝑞𝑞 in the scene), an emission term at this point is 
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added. To determine the emission power, an occlusion ray is traced towards the sun. If this point is 
directly illuminated, i.e., the occlusion ray intersects nothing, the temperature of the sunlit component is 
used. Otherwise it uses the temperature of the shaded component. The emitted radiation is calculated by 
using Planck’s law with emissivity provided. Except for the emission term, another component of the 
power that goes into the sensor is the reflected power, which is emitted by other objects in the scene or 
sky radiation. In order to consider this part of the power, a random point on a randomly selected emitter 
(including the sky) is sampled (e.g., 𝑞𝑞𝑒𝑒 in Figure 5). When this point is not on the sky, the emission 
power is determined by sending an occlusion ray towards the sun. The contribution of power from this 
point is calculated by using the BSDF defined at point 𝑞𝑞 if this point is not occluded by other objects. 
This procedure can be recursively repeated, which is the same as the procedure described in section 2.2 
except for the emission term. Finally, a thermal infrared image, which records the radiance value, can be 
simulated.

Figure 5. Simulation of thermal infrared radiation using backward path tracing.

2.4 Addition of fluorescence photons

Based on FLUSPECT, LESS simulated canopy chlorophyll fluorescence with multi-angle and 
multi-imaging modes.

2.4.1 FLUSPECT model

Based on PROSPECT, FLUSPECT not only simulates the reflectance and transmittance of leaves, 
but also simulates the forward and backward-excited chlorophyll fluorescence of leaves. The model takes 
into account the reabsorption of fluorescence in the leaves. A fast layer doubling algorithm is used for 
fast solution (Vilfan et al., 2016,2018).

FLUSPECT converts the excitation spectrum (𝐸𝐸351×1 ) ranging from 400 to 750 nm into a 
fluorescence spectrum (𝐹𝐹211×1) ranging from 640 to 850 nm using the fluorescence excitation matrix 
(𝐸𝐸𝐸𝐸211×351). The spectral interval is 1 nm. Due to the spectral sampling interval of 𝐸𝐸𝐸𝐸211×351, in LESS, 
it is specified that the spectral interval for both excitation and fluorescence spectra should be equal, fixed, 
and an integer number(eg. 5 nm). The resampling of 𝐸𝐸𝐸𝐸211×351  to other spectral intervals requires 
considering how the cumulative multiplication and addition of the excitation spectrum can be achieved 
on the new spectral intervals. Here, without going into derivation, the resampling method is provided.

𝐸𝐸𝐸𝐸𝑢𝑢,𝑣𝑣� =
∑∑𝐸𝐸𝐸𝐸𝑖𝑖,𝑗𝑗
𝑖𝑖𝑖𝑖𝑖𝑖

, 𝑖𝑖𝑖𝑖𝑖𝑖 ∈ N+

Among them, 𝐸𝐸𝐸𝐸𝑖𝑖,𝑗𝑗 is the original matrix aligned with the resampled 𝐸𝐸𝐸𝐸�  after zero-padding, and inc 
represents the wavelength interval after sampling. Figure 6 shows the deviation caused by resampling, 
with a sampling interval of 5 nm, which can achieve a good balance between simulation time and 
accuracy requirements.
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Figure 6. With the increase of sampling interval, the deviation caused by resampling gradually 
increases.

2.4.2 RT of fluorescence in the canopy of three-dimensional surface element

In LESS, the concept of "ray bundle" is adopted, which means that each ray (photon) contains 
energy from multiple spectral bands. In order to record ordinary photons and fluorescence photons, it is 
necessary to generate photons within the wavelength range of 400 - 850 nm, with a total of n spectral 
bands. The energy carried by ordinary photons is denoted as 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡,1×𝑛𝑛, PSI fluorescence photons as 
𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃,1×𝑛𝑛, and PSII fluorescence photons as 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃,1×𝑛𝑛. Among them, the energy in the range of 400 - 750 
nm will excite fluorescence in the leaf at 640 - 850 nm.

At this stage, the process of exciting 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃,1×𝑛𝑛 and 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃,1×𝑛𝑛 by 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡,1×𝑛𝑛 is described using the 
expanded fluorescence excitation matrix (𝑀𝑀𝑛𝑛×𝑛𝑛). The scattering process of photons is described by the 
scattering matrix. They are represented as follows:

𝑀𝑀𝑛𝑛×𝑛𝑛 = �𝑂𝑂 𝐸𝐸𝐸𝐸�T

𝑂𝑂 𝑂𝑂
� ,𝑅𝑅𝑛𝑛×𝑛𝑛 = 𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑{𝑟𝑟1, 𝑟𝑟2, 𝑟𝑟3, … , 𝑟𝑟𝑛𝑛}

where, 𝐸𝐸𝐸𝐸� T represents the transpose of the resampled fluorescence excitation matrix at the intersection 
point of the ray. It is assumed that backward fluorescence is transmitted along with reflected rays, and 
forward fluorescence is transmitted along with transmitted rays. r represents the reflectance or 
transmittance at the intersection point of the ray. When r represents reflectance, 𝐸𝐸𝐸𝐸�   represents the 
backward fluorescence excitation matrix. When r represents transmittance, 𝐸𝐸𝐸𝐸�  represents the forward 
fluorescence excitation matrix. The description of the fluorescence excitation process is as follows:

�
𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃,1×𝑛𝑛 = 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡,1×𝑛𝑛 × 𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃,𝑛𝑛×𝑛𝑛
𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃,1×𝑛𝑛 = 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡,1×𝑛𝑛 × 𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃,𝑛𝑛×𝑛𝑛

,

the photon scattering process is described as follows:
𝐿𝐿𝑜𝑜𝑜𝑜𝑜𝑜,1×𝑛𝑛 = 𝐿𝐿𝑖𝑖𝑖𝑖,1×𝑛𝑛 × 𝑅𝑅𝑛𝑛×𝑛𝑛.

Then, when the light intersects with the material that emits fluorescence, the various photon energy 
changes as follows:

⎩
⎪
⎨

⎪
⎧ 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃 𝑜𝑜𝑜𝑜𝑜𝑜,1×𝑛𝑛 = 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡 𝑖𝑖𝑖𝑖,1×𝑛𝑛 × 𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃,𝑛𝑛×𝑛𝑛
𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 𝑜𝑜𝑜𝑜𝑜𝑜,1×𝑛𝑛 = 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡 𝑖𝑖𝑖𝑖,1×𝑛𝑛 × 𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃,𝑛𝑛×𝑛𝑛
𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡 𝑜𝑜𝑜𝑜𝑜𝑜,1×𝑛𝑛 = 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡 𝑖𝑖𝑖𝑖,1×𝑛𝑛 × 𝑅𝑅𝑛𝑛×𝑛𝑛 + 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃 𝑜𝑜𝑜𝑜𝑜𝑜,1×𝑛𝑛 + 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 𝑜𝑜𝑜𝑜𝑜𝑜,1×𝑛𝑛

= 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡 𝑖𝑖𝑖𝑖,1×𝑛𝑛 × �𝑅𝑅𝑛𝑛×𝑛𝑛 +𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃,𝑛𝑛×𝑛𝑛 + 𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃,𝑛𝑛×𝑛𝑛�

,

might as well write 𝑇𝑇𝑛𝑛×𝑛𝑛 = 𝑅𝑅𝑛𝑛×𝑛𝑛 + 𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃,𝑛𝑛×𝑛𝑛 + 𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃,𝑛𝑛×𝑛𝑛, then 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡 𝑜𝑜𝑜𝑜𝑜𝑜,1×𝑛𝑛 = 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡 𝑖𝑖𝑖𝑖,1×𝑛𝑛 × 𝑇𝑇𝑛𝑛×𝑛𝑛.
It is feasible to calculate fluorescence photon energy at each intersection point, but it involves a 

large computational cost and is generally not performed at every point. Instead, a cumulative transfer 
matrix is commonly used to calculate the conversion matrix between the energy of the light source and 
the energy received by the sensor.

Considering a forward tracing path of a ray with fluorescence, the changes in photon energy by two 
surfaces are illustrated in Figure 7.
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Figure 7. A ray of light containing fluorescence intersects the surface.
For fluorescence, after the light intersects with the fluorescent surface i, in addition to the excited 

fluorescence, there is also scattered fluorescence, then the emitted light is:

⎩
⎪
⎨

⎪
⎧ 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖 = 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑖𝑖−1 × 𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃

𝑖𝑖 + 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖−1 × 𝑅𝑅⬚
𝑖𝑖

𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖 = 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑖𝑖−1 × 𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃
𝑖𝑖 + 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖−1 × 𝑅𝑅⬚

𝑖𝑖

𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑖𝑖 = 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑖𝑖−1 × 𝑅𝑅⬚
𝑖𝑖 + 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖 + 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖

= 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑖𝑖−1 × 𝑇𝑇⬚
𝑖𝑖

,

after the light emitted from the face i intersects with the face i+1, the light emitted is:

⎩
⎪
⎨

⎪
⎧ 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖+1 = 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑖𝑖 × 𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃

𝑖𝑖+1 + 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖 × 𝑅𝑅⬚
𝑖𝑖+1

𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖+1 = 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑖𝑖 × 𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃
𝑖𝑖+1 + 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖 × 𝑅𝑅⬚

𝑖𝑖+1

𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑖𝑖+1 = 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑖𝑖 × 𝑅𝑅⬚
𝑖𝑖+1 + 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖+1 + 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖+1

= 𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑖𝑖−1 × 𝑇𝑇⬚
𝑖𝑖 × 𝑇𝑇⬚

𝑖𝑖+1

.

The light propagation process maintains good consistency. If we concatenate the three components 
of a ray into a row vector of size 3×n, denoted as �𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡⬚ , 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃⬚ , 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃⬚ �, then the energy of the outgoing 
ray at surface i can be represented as:

�𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑖𝑖 ,𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖 ,𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖 �1×3𝑛𝑛 = �𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑖𝑖−1 ,𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖−1,𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖−1 �1×3𝑛𝑛 × �
𝑇𝑇⬚
𝑖𝑖 𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃

𝑖𝑖 𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃
𝑖𝑖

𝑂𝑂 𝑅𝑅⬚
𝑖𝑖 𝑂𝑂

𝑂𝑂 𝑂𝑂 𝑅𝑅⬚
𝑖𝑖
�

3𝑛𝑛×3𝑛𝑛

= �𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑖𝑖−1 × 𝑇𝑇⬚
𝑖𝑖 ,𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑖𝑖−1 ×𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃

𝑖𝑖 + 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖−1 × 𝑅𝑅⬚
𝑖𝑖 ,𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑖𝑖−1 × 𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃

𝑖𝑖 + 𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑖𝑖−1 × 𝑅𝑅⬚
𝑖𝑖 �

From the changes in energy of the two rays mentioned above, we can summarize the energy 
variation of a ray from the light source to the sensor during the entire process. The ray emitted from the 
light source without fluorescence components can be represented as �𝐿𝐿𝑒𝑒⬚, 0,0�. Therefore, the energy of 
the ray reaching the sensor is:

(𝐿𝐿𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑁𝑁 ,𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑁𝑁 ,𝐿𝐿𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑁𝑁 )1×3𝑛𝑛 = �𝐿𝐿𝑒𝑒⬚, 0,0�1×3𝑛𝑛 × ��
𝑇𝑇⬚
𝑖𝑖 𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃

𝑖𝑖 𝑀𝑀𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃
𝑖𝑖

𝑂𝑂 𝑅𝑅⬚
𝑖𝑖 𝑂𝑂

𝑂𝑂 𝑂𝑂 𝑅𝑅⬚
𝑖𝑖
�

3𝑛𝑛×3𝑛𝑛

𝑁𝑁

𝑖𝑖=1

Thus, the fluorescence energy in a ray and the total radiation energy containing fluorescence at the 
sensor are obtained (Regaieg et al., 2023). On this basis, the calculation process is simplified and the 
fluorescence simulation efficiency is greatly improved.

3. Installation
Windows

Download the installer from http://www.lessrt.org. All you need is just to choose a place to install it. 
(Usually, LESS cannot be installed in c:\program files, since it does not have administrative rights.). After 
installation, LESS will be automatically started. 

http://www.lessrt.org/
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4. Graphic User Interface (GUI)
LESS window is divided into four areas (Figure 7):
 The area 1 is Preview Panel
 The area 2 is Parameter Control Panel
 The area 3 is Progress Panel
 The area 4 is Menu Panel

4.1 Preview Panel
Preview Panel  is for displaying some information, such as 
view azimuth angle ( ), sun azimuth angle ( ), sensor footprint 
(  ) and tree positions. This will make it easier for user to set parameters, because this display is 
automatically updated when related parameters are changing.
Background Image ( ) - When you click the icon, you can choose a picture as background image, make 
sure that the image represents the same area defined in LESS.
Delete Background Image ( ) - When you click the icon, background image will be delete.
Zoom-in ( ) - This icon allows you to zoom-in the area covered by grids.
Zoom-out ( ) - This icon allows you to zoom-out the area covered by grids.
3D Viewer ( ) - If you click this icon, 3D Viewer will be activated. In 3D Viewer windows, you can 
visualize the scene in advance (before actual simulation) to verify the 3D scene.
Polygon ( ) - When you check the icon, you can draw a 
polygon in the area covered by grid and set polygon parameter 
(such as the minimum distance between trees, tree position in 
the polygon) in the panel after it ( ). If you just 
want to allocate objects in some particular areas, the solution is 
using Polygon tool. Check the option of Polygon under the 
display panel. This time when your mouse enters the display 
panel, it will become a hand. you can create a polygon by left 
click. If you want to remove the polygon, just use your right click of mouse. After the creation of polygon, 
you can delete or add object instances in this area. If you click Add, then all the generated instances will 
only apprear in the polygon, the position and number of each object are still random within the polygon. 
However, if you choose one of the objects in the Objects List. then the generated instances only contains 
this object. This tool can create some forest scene which contains one species of trees in some area and 
another species of tree in another areas.
Point ( ) - When you check the icon, you will see the cursor changing to a hand. You can choose the 
position of tree by clicking the place where you want the tree to be, without inputting coordinates.

4.2 Parameter Control Panel
Parameter Control Panel  is for setting parameter which can control the scene you simulate.

4.2.1 Sensor

To simulate a sensor you can input parameters here to control image type, the number of pixels in 
width and height, sample count per pixel.
Type - Up to now, there are four types that you can choose. They are orthographic, perspective, 
CircularFisheye, PhotonTracing.
Width - The number of pixels in width.
Height - The number of pixels in height.
Samples - sample count per square meter. Usually 128 is sufficient. If you increase to 256, 512, the 
quality of the simulated image will be better. 

Figure 8. Main Screen of LESS

  Figure 9. Polygon tools    
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Spectral Bands - It represents the which band you want to 
simulate. For example, RED and NIR: 660nm，900nm. Now, you 
must also input a bandwidth for each band with the format 
of “center band: bandwidths”, e.g. 660:10,900:10. These 
bandwidths will be used for determining the irradiance. If you 
have no special requirement, it can just set the bandwidth to zero. 
And when you click [Define], you can define the bands by input 
some parameter in the pop-up window (Figure 8).

Image Format - “Spectrum” means generating spectral image. 
“Synthesized RGB Image” means generating RGB image.
Only First Order? - If it is true, it means LESS only simulate the first-scattering event (sun * radiation 
reflected by objects only one time). If set to false, then both first-scattering and multi-scatting will be 
simulated.
Virtual Plane – When you check it, a virtual plane is defined, and only the radiant that exits through the 
plane is calculated. In Figure 9, you 
can define the location of the virtual 
plane in “Center” and the size of the 
virtual plane in “Size”. Usually, the 
height of the plane (Z) should be left as default, i.e., MAX.
Thermal Radiation - When you 
need to get thermal infrared image, 
you can check it. After checking, 
you can input surface temperature 
parameter in Optical Database 
(Figure 10).
NoData Value - Set the background 
value when sensor footprint is 
beyond the scene scale. If the image opened by ENVI, you should set it as “0”.
Repetitive scene - Sets the number of copies that distributed around the scene.
Width Extent/Height Extent - The actual extend of the orthographic sensor can simulate. It is similar to 
FOV of perspective sensor. 
Four Components Product - If you check it, a classification image will be generated. The classification 
image has four components, and they are sunlit ground, sunlit canopy, shaded ground and shaded canopy. 
The corresponding pixel values are 1, 2, 3 and 4, respectively. Please note that some pixels may mixed 
pixels, in this case, the dominant component is set as the pixel component type. However, if you set the 
number of bands >= 5, the generated four component image will contain 5 spectral bands, the first band 
is the classification image, the other four bands are the proportions of the four components. This can be 
used to estimate directional gap fraction of forest canopy.

4.2.2 Observation

View Zenith - Set view zenith angle (angle between vertical direction).
View Azimuth - Set view azimuth（0° is north, clock-wise to 360°).
Sensor Height - Set the height of the sensor.

4.2.3 Illumination & Atmosphere

There are two groups of illuminations, one is from sun, other is from atmosphere.
Sun Zenith - Zenith angle of sun.
Sun Azimuth - Azimuth angle of sun (0° is north, clock-wise to 360°).
This defines the position of sun. That means if you set it as 90° (East), then it will produce shadows in 

Figure 10. Spectral bands

Figure 11. Virtual plane

Figure 12. Temperature definition



LESS Manual

13

West. 
Sun Position Calculator - If you clicked it, you can fill in above two parameters by inputting the time and 
place parameters for the scene.
Next is the parameter setting for the sky.
Type - It represents the type of atmosphere radiation, now only one option can be used - 
“SKY_TO_TOTAL”，it means the ratio between diffuse radiation and total incident radiation. Thus (1-
SKYL) * T (T is sun radiation above atmosphere) is the sun radiation under atmosphere. Under this mode, 
atmosphere is isotropic diffuse radiation from upper hemisphere.
Percentage - It defines the actual ratio between atmosphere radiation and total radiation. What should be 
noticed is that when you input the values, the number of values should be equal to the number of bands 
(under the sensor section). That is, for each band, it may have different values.
Input solar spectrum manually - If you check it, you can input the solar spectrum and the sky spectral in 
terms of wavelength manually (in W/m2/nm).

4.2.4 Optical Database

Since objects in LESS are represented as triangular meshes, thus for each triangle, it can have at 
least three kinds of optical properties: reflectance of front side, reflectance of back side, and transmittance 
(we assume transmittance of both side is the same). In Optical database, we should first define some 
optical model, and then they can be used in the following terrain or forest definition. By default, there 
are three optical models defined. Please note that, these three optical models cannot be modified, if you 
want to use them with modified value, you should copy a new one and then perform the modification 
You can also add new optical model directly. For each reflectance or transmittance, values of different 
bands are connected by comma.

Please note that for some object component, such as trunk, the normal of some triangles may face 
inside, which shows a zero reflectance outside. To avoid this situation, a convenient solution is to set the 
reflectance of both outer and inner side to the same values, but with zero transmittance.

4.2.5 Terrain

There are mainly three types of terrain: PLANE, RASTER, MESH.
PLANE just represents simple plane lies at altitude of 0. RASTER is a raster image file in ENVI standard 
format.
XSize - Size in the X direction.
YSize - Size in the Y direction.
There are two BRDF types: Lambertian, Soilspect. If Lambertian is chosen, it means you think of the 
ground as a Lambertian. If Soilspect is chosen , you can input parameters to define the model.
Land Cover - If you check it, you can input surface classification data generated by ENVI, and then set 
different spectrum for different ground classes.

4.2.6 Objects

Objects define what you want to put in the scene. For example, forest is formed by a number of 
single trees, which are describe by triangle mesh (obj file) in LESS. Usually, we cannot input a obj for 
each single trees, since forest contains a lot of trees and a tree itself contains numerous triangles, it may 
not be possible even for large memory computers. The alternative is to use a “instance” technique. That 
means we define a single tree, and we can place it at different places, just using reference, thus the 
program only keeps one copy of the triangle mesh, but it represents trees at different places (they have 
exactly the same structures, but we can do rigid transformations). 
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Objects window is divided into three areas:
• The area (1) is Objects Define Panel;
• The area (2) is Position Parameter Control Panel;
• The area (3) is Display Panel.
(1) Objects Define Panel
The first step is to define some objects (single tree). 
Define Object… - You can click it to define objects. It will open a 
new dialog that allows to import obj file (Figure 11).
Add - We give a name for our first object, such as “birch”. After 
clicking [Add] button, “birch” will appear in the Objects list.
Import OBJ - Selecting the name we write in “Objects” area, then the button [Import OBJ] is activated. 
If you click the [Import OBJ], you can choose a obj file 
in the window and input it as the object (Figure 12). 
And then you need to determine the scale by the units 
of the tree model that you enter into. If the units of the 
tree model that you enter into is “cm”, the scale should 
be 0.01. And if the units of the tree model that you 
enter into is “m”, the scale should be 1.00.
Import from RAMI - Import objects from the model 
file on the rami website. After importing objects, each component of the obj file will appear in the 
“Components” list. Component is a part of the object, e.g. a tree contains leaves and branches (usually 
they have different optical properties). You should be aware that the obj file itself will be copied to 
the simulation folder, so you can safely delete it from your original place.
Optical Property - Selecting one of the components, the [Optical Property] is activated and you can 
choose an optical property for the selected component. These optical properties are also from “Optical 
Database”. If you need to define a new optical model, you can go back to “Optical Database” page 
without closing the current window. When you finish, the optical models are automatically synchronized.
3D Display - After clicking it, you can see the 3D model of object (Figure 13).
After defining objects, you should click [OK] button, and 
then we will go back to Objects page with the defined 
objects shown in Objects list.
(2) Position Parameter Control Panel
If we select the defined objects, we can define its positions. 
There are three methods to define positions. The first 
method is inputting coordinate for the object directly. The 
second method is using [Point] tool provided by LESS 
(introduced in Preview Panel). The third method is using 
[Random] tool provided by LESS. The last method is 
import CHM data to control position.
Add - You can enter coordinates in the table before [Add] button, and then clicking [Add], the object is 
added to the specified location.
Random - Clicking the button [Random], it will open a new window, now the only choice is Poisson 
distribution (This is very normal for trees in forest). The only parameter you need to provide is the 
minimum distance between two objects. Click [OK], then LESS will automatically generate instances of 
defined objects. The number and position of each object in the Objects list is also random. Thus, you can 
get a reasonable distribution of objects.
From CHM - Clicking the inverted triangle next to the button [Random], you can open the drop-down 
menu, and find the [From CHM] button. If click it, you can choose a CHM data as a basis for objects 
location.
(3) Display Panel

Figure 13. Objects definition

Figure 14. Import obj file

Figure 15. 3D Display
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Display on 2D map - If a position is added when you check it, the position will appear on the grid area 
in Preview Panel, which will help you to check whether it is correct.
Hide selected Objects - If there are multiple plants in this scene, you can hide the location of the model 
you don't want to see by checking it.

4.3 Progress Panel
This panel shows the running state of the current program. When an error occurs, you can find the 

reason of the error by reading this panel.

4.4 Menu Panel
Menu bar holds 6 menus:  File, Run, Tools, Display, Process and Help

4.4.1 File menu

File > New Simulation - Create a new simulation.
File > Open Simulation - Open a chosen LESS file and load its parameter values into LESS modeler.
File > Save - Save current parameter values on a disk as LESS file.
File > Save as - Save the tree image into another file.
File > Close - Close the simulation.

4.4.2 Run menu

Run > Run All - Run this program and output results.
Run > Generate 3D Model - Generate 3D objects, e.g., convert obj file into binary format.
Run > Generate View & Illumination - Generate viewing parameters for simulation.
Run > less - Run less simulation

4.4.3 Tools menu

Tools > Open Results Folder - Open Results Folder of current simulation.
Tools > Batch Tools - Do batch processing.
Tools > Server Setting - Do network parallel simulation
Tools > LAI Calculator - Calculate LAI in different resolution, and output the results as txt.
Tools > Python Console - Run Python scripts (under experiment).

4.4.4 Display menu

Display > 3D Viewer - Display scene you simulate from multiple angles.
Display > 3D Viewer (Bounding BOX) - Display scene you simulate from multiple angles with replacing 
objects with boxes.
Display > 2D Polygon - Draw a polygon in the area covered by grid and set polygon parameter (such as 
the minimum distance between trees, tree position in the polygon) in the panel after it.

4.4.5 Process menu

Process > BRF Processing - Generate BRF image.
Process > Brightness Temperature Processing 

4.4.6 Help menu

Help > Documentation - Documentation of LESS.
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5. Practical tutorial

5.1 Major functionalities

5.1.1 FPAR simulations

FPAR is the fraction of total absorbed radiation, usually from 400 to 700 nm. Therefore, to simulate 
FPAR using LESS, we need first to set the band range from 400 to 700 nm (or other spectrum if you 
want), the band number can be, e.g., 30. Then you need to set the leaf and soil optical properties in 
[Optical Database] section, the number of spectrum bands should be the same with the band number 
you set in the [Sensor] section, e.g., the 30 you have previously set.

Figure 14. Set the spectral bands for FPAR simulation.

Next step is to enable the FPAR option in [sensor] section as illustrated in Figure . An important 
parameter is the Layer definition (Start:Interval:End), which defines how FPAR is outputted. 
Specifically, LESS only outputs the FPAR values between Start and End range with interval equal to 
Interval. For example, if you define it as 0:2:10, then you will get FPAR for layers: [0,2), [2,4) , [4,6) , 
[6,8) , [8,10). 

  
Figure 15. Enable FPAR simulation in LESS and define layers.

A simulation example is shown in Figure , the file can be found in the Results folder within the 
simulation folder. The results five two kinds of product, one is the spectrally integrated total FPAR, the 
other is the absorption for each band. For each layer, we first integrate the total PAR over the whole 
spectrum range, and then divided by the total incident energy received by a plane at the top of the canopy 
（also integrated over the whole spectrum range）(Figure ). The total FPAR is presented at the top of 
the result file ((Figure  left), it illustrates the total FPAR (TfPAR) for each layers, e.g., from 0 m to 2 
m, the total FPAR is 0.3839, which may be mainly absorbed by soil. If you are interested in leaves, maybe 
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you should look at the 4th column, it outputs the FPAR for the leave components. Please note that the 
name of the column is not fixed, it is according to the component you defined in LESS when you import 
your OBJ file into LESS. If you don’t want the spectrally integrated FPAR, you can refer to the 
**Absorption for each band**, here, the FPAR for each band is presented. ‘- Total Absorption’ means 
the total absorbed energy for all the landscape components (e.g., leaves, soil and branches) for each band. 
The column means the spectral bands, thus you would see 32 columns if you set the spectral bands to 30, 
the first two columns are layer heights. Next content is the FPAR or absorption for other landscape 
components, for example the tree_leaves. In conclusion, if you are interested in the total and spectrally 
integrated FPAR, you only need to refer to the first section of the result file.

 
Figure 16. FPAR simulation example: simulation results (left); total FPAR calculation.

5.1.2 LiDAR simulations

Up to now, less has provided airborne laser scanning (ALS) and ground laser scanning (TLS) data 
simulation in graphical user interface, The simulator can get different types of data through file 
configuration, such as full waveform and 3D point cloud data, including single-band, multi-band and 
even hyperspectral LiDAR scanning (HLS) data. The laser simulator is located in GUI extension module. 
You should use the mouse to indicate [Extensions] and click on the button [LiDAR Simulator]. You can 
see Figure  for the specific operation of opening the simulator.

Figure 17.  LiDAR simulator interface

Before starting the simulation, you also need to understand the configuration of each parameter 
so that you can get interested LiDAR data in the simulator. Parameters are divided into two 
categories. The sensor parameters are located on the left side of the GUI, and the platform 
parameters are located on the right side. The meaning of each parameter is presented in Table 1, 
Table 2 and Table 3, Some parameters are also presented in Figure  to help users better understand.
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Table1. Sensor parameters

Sensor Area
Sensor size (area) of LiDAR receiving energy, The sensor size (area) 
of LiDAR receiving energy, the larger the sensor area, the more 
energy it can receive.

Footprint half angle Field angle of LiDAR pulse. Note: This is half of the cone angle of 
the field of view.

FOV half angle

FOV represents the field of view range of LiDAR receiving energy, 
which is set to half of the cone angle of the field of view. The larger 
the value, the larger the acceptable range. Generally, you need to set 
FOV half angle larger than footprint half angle. See Figure. 15 
specifically

Acquisition rate 
(Period)

The acquisition rate represents a certain sampling interval and is 
usually determined by the instrument itself.

Half duration (Number 
of sigma)

The emission energy of laser pulse is usually assumed to be a 
Gaussian distribution function related to time and amplitude. 
±3σrepresents the effective information range of the whole pulse 
energy. Note: Half duration represents half of the effective energy 
range.

Half pulse duration at 
half peak

Half pulse duration at half peak represents the standard deviation of 
Gaussian pulse energy. Half duration and Half pulse duration at half 
peak together determine the effective information range of pulse 
energy.

Axial division

The cross section of laser pulse is divided into n*n equal parts, and 
then sub-beams are emitted. The n here is the Axial division. This is 
only valid for multi-ray point cloud simulation. The larger the value, 
the finer the simulation of each pulse, but the simulation time is 
longer.
Table 2. ALS platform parameters

Altitude
The flying height of the platform where the LiDAR is located, which 
is relative to the zero point of the scene rather than the terrain. See 
Figure. 15 specifically.

StartX, StartY, EndX, 
EndY

The start point and end point of ALS scanning, the projection of these 
points on the ground, the platform will fly in a straight line from the 
point (StartX, StartY, Altitude) to (EndX, EndY, Altitude). See 
Figure. 15 specifically.

Swath width Width of Lidar scanning (horizontal width of vertical to flight 
direction). See Figure. 15 specifically.

Along track resolution
(Yaw resolution)

Pulse interval along flight direction (ground distance). See Figure. 15 
specifically.

Cross track resolution
(Range resolution)

Pulse interval of vertical to flight direction (ground distance). See 
Figure. 15 specifically.

Min range, Max range
The range data [Min range, Max range] in this vertical direction can 
be collected and saved by the LiDAR sensor. See Figure. 15 
specifically.
Table 3. TLS platform parameters

TLS position X, Y, Z Location of TLS scanning. X, Y is the horizontal projection position 
of the ground, and Z is the height of the instrument.

Center zenith,
Center azimuth The position of the bisector of zenith angle or azimuth angle.

Delta zenith,
Delta azimuth

Range size of zenith angle or azimuth angle. Zenith angle range is 
generally set from 0 to180. Azimuth angle range is generally set from 
0 to 360.

Resolution zenith,
Resolution azimuth

The angle formed by two connected sampling points in zenith angle 
or azimuth is called angular resolution. The higher the angular 
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resolution, the higher the point cloud density.
Cross track resolution

(Range resolution)
Pulse interval of vertical to flight direction (ground distance). See 
Figure. 15 specifically.

Echo Detection Model
LiDAR simulator provides two detection modes, one is simple and 
the other is Gaussian. Gaussian decomposition is used to solve the 
parameters, and the waveform is decomposed to obtain discrete 
points, so the simulation is slow but accurate.

Figure 18.  Illustration of LiDAR related parameters

 Discrete point cloud data simulation

Note that before starting the simulation, you must build a project and configure the scenes you 
are interested in according to the operation tutorial in section 4.2. Furthermore, you need to 
configure the parameters of sensors and platforms according to the simulator interface. Finally, you 
can start your discrete point cloud simulation work. Using the mouse to indicate [RUN] and click 
the button [Generate ALL], The simulator starts to generate 3D scenes and LiDAR configuration 
parameters. Then click button [Single ray point cloud] or button [Multi rays point cloud] to 
simulate point cloud. The former emits one light for each pulse, so the computer is faster. The latter 
emits multiple rays for each pulse (the number is determined by Axial division). In this mode, the 
full waveform is first simulated internally, and then discrete points are obtained by Gaussian 
decomposition, so the calculation speed is slower than [Single ray point cloud] mode. The 
simulation results can be found in the Results file. The results of two different modes correspond to 
singleRay and pointcloud folder. The results of point cloud generated by [Single ray point cloud] 
and [Multi rays point cloud] are presented in Figure , respectively.

  
Figure 19.  Simulation results of single ray point cloud (left); Simulation results of multi ray point cloud 
(right).
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 Single ray point cloud simulation results

Single ray point cloud simulation results are located in the singleRay folder, the results of 
single ray point cloud simulation record the XYZ coordinates, intensity and other related 
information of discrete point cloud data (Figure16). Less In order to meet the needs of different 
users, better use LiDAR simulator to obtain more useful data. It is worth noting that when users 
input spectral information of different bands, multi-spectral or even hyperspectral discrete point 
cloud data will be obtained in [Single ray point cloud] mode. At the same time, the [Single ray

point cloud] mode may provide users with more humanized data, and the simulation results also 
record the types of ground objects that each pulse touches during transmission, which may make 
users analysis more convenient. Different types of ground objects touched by lidar pulses are 
recorded in the last column of the result file. An example of simulating discrete point clouds with a 
single ray is shown in Figure .

Figure 20.  Example of simulating discrete point cloud with single ray.

 Multi ray point cloud simulation results

Multi ray point cloud simulation results are located in the pointcloud folder, the results of 
Multi ray point cloud simulation record the XYZ coordinates, Return Number, Number of Return, 
intensity and other related information of discrete point cloud data (Figure17). Note that the result 
file also records the band index fields of different point clouds. Therefore, multispectral or even 
hyperspectral discrete point cloud data acquisition is also supported in [Multi rays point cloud] 
mode. Compared with [Single ray point cloud] mode, [Multi rays point cloud] mode requires 
users to further filter and separate the discrete point cloud data of different bands according to the 
band index fields. An example of simulating discrete point clouds with a Multi rays are shown in 
Figure .

Figure 21.  Example of simulating discrete point cloud with multi ray.
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The above shows the LiDAR point cloud data simulated in two different modes: [Single ray 
point cloud] and [Multi rays point cloud]. Compared with [Multi rays point cloud] mode, [Single 
ray point cloud] provides more friendly simulation results, which is convenient for users to further 
analyze. [Multi rays point cloud] mode obtains finer results，In the above example, two different 
modes simulate the same scene, and the number of point clouds obtained by [Single ray point cloud] 
mode and [Multi rays point cloud] mode is 2091 and 6172 respectively. 

Of course, in addition to the above two modes, LESS also provides an advanced mode of 
[Multi rays point cloud]. The user can use the mouse to indicate [Advanced] and click the [Muti 
rays point cloud incident] button (Figure 20). Like other simulation forms, users can find the 
results of advanced version simulation in the Results folder. The corresponding folder is 
pointcloudIncident. [Muti rays point cloud incident] mode is based on the development of [Multi 
rays point cloud] mode, Therefore, the simulation results not only record the results of [Multi rays 
point cloud] mode, but also record the incident energy of each pulse and the energy intercepted by 
ground objects during the pulse transmission, Incident energy and intercepted energy are recorded 
in the last two columns in the result file respectively. Different modes depend on the research needs 
of users, which also allows users to choose different modes of simulation data more flexibly.

  
Figure 22.  Example of simulating Muti rays point cloud with incident mode.

 Full-waveform Multi/Hyperspectral Lidar

Using the mouse to indicate [RUN] and click the button [Generate ALL], The simulator starts 
to generate 3D scenes and LiDAR configuration parameters. Then click button [Single ray point 
cloud] or button [Multi rays waveform] to simulate the data. The simulation results can be found 
in the Results folder. The results of two different modes correspond to singleRay and records folder. 
However, the result is only the data of intermediate process, which is not the full waveform data 
that can be used effectively. Using the mouse to indicate [Process] and click button [Convolve] to 
perform convolution operation. Finally, the full waveform data is obtained, and the results can be 
found in convolved_waveform folder. This result is composed of two files, It's 0.txt and pos_0.txt 
respectively (Figure ).
[0.txt] records all waveform data.

The number of pulses is the number of rows of recorded data divided by bins in which each 
pulse is dispersed. Therefore, the first pulse is 0 to the NumberofBinsForEachPulse-1 line. 
The second pulse is NumberofBinsForEachPulse to the 2* NumberofBinsForEachPulse-1 
line. By analogy, all pulses can be read. The first column of the file is the distance from the 
starting position of each pulse bin to the sensor, and the second column to the last column is 
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the echo intensity of each band. The visualization of full waveform multispectral LiDAR data 
is shown in.

[Pos_1.txt] records the position information of the pulse. 
The first three columns are the XYZ coordinates of the pulse starting position, that is the sensor 
position. The last three columns are the reflection direction of each pulse, at the same time, the 
coordinate system is consistent with the coordinate system of LESS GUI.

  
Figure 23. Example of 0.txt (left); example of pos_0.txt (middle); simulated hyperspectral waveform 
(right).

5.1.3 Simulations of Multi-Spectral Image

Open the LESS main program (as shown in Figure 24), and then create a new simulation project 
by selecting [File]-> [New Simulation]. Create a new directory named “Ex01” and choose it as the 
directory for the project. If the project is created successfully, you will see the message “Succeed: 
‘save path’” in the [Console] area.

Figure 24.   LESS main program window



LESS Manual

23

Define the parameters related to the sensor in the [sensor] window. The main parameters and 
their descriptions are as follows (default parameters can be kept for those not mentioned):

Parameter Number Explanation

Type Orthographic Sensor type, where Orthographic represents a 
parallel projection camera.

Width [pixels] 500 The final simulated image width in pixels.

Height [pixels] 500 The final simulated image height in pixels.

Samples [/pixel] 32

The number of rays emitted per pixel, which is 
generally related to the complexity of the scene, 
with common values such as 32, 64, 128, etc. A 
larger value will result in more accurate results, but 
will also increase computation time. (When the 
spatial resolution is 1m, it can be set to 64).

Spectral Bands 600:2,900:2 The simulated bands are 600nm and 900nm, with a 
band width of 2nm.

Image Format Spectrum

The output format of the final image, where 
Spectrum represents outputting the multi-band 
format and saving it in the ENVI standard format. 
RGB image outputs a png format image that is 
automatically synthesized by the program in visible 
light.

Only First Order Uncheck
If selected, it means that only a single scatter is 
simulated, and the multiple scattering term is 
ignored.

NoData Value -1.0
If the sensor field of view exceeds the scene size, 
the pixel values of the area outside the range are set 
to the specified value.

Repetitive scene 100
The horizontal expansion of the scene to simulate 
the scenario of extending infinitely in the horizontal 
direction.

Width Extent [m] 100
The field of view size for a parallel projection 
sensor (other types of sensors do not have this 
parameter).

Height Extent [m] 100 The field of view size for a parallel projection 
sensor.

 【Observation】

For a parallel projection camera, the main parameters to be set for the observation geometry 
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are the [view zenith] angle and the [view azimuth] angle. The azimuth angle increases in a 
clockwise direction starting from the north direction of 0°, with the south direction being 180°. In 
LESS, the field of view for the parallel projection camera is actually a cube, with the scene contained 
within the cube. The final image plane is the bottom of the cube, and the distance between the image 
plane and the scene center is determined by the [sensor height] .(Figure 25)

Figure 25.   Field of view for a parallel projection camera.

 【Illumination & Atmosphere】

Parameter Number Explanation

Sun Zenith 45 Solar zenith angle.

Sun Azimuth 90 Solar azimuth angle.

Sky-Type SKY_TO_TOTAL
Type of scattered light in the sky: SKY_TO_TOTAL 
represents the proportion of sky light to total incident 
light.

Sky-Percentage 0,0 Proportion of sky light incident in each band.

Note: If "Input solar spectrum manually" is checked,the solar and sky incident spectra can be 
manually entered.

 【Optical Database】

In this exercise, the default values can be kept. In fact, the Optical Database defines a series of 
spectra for setting the optical properties of the ground and scene elements. In LESS, spectra include 
front reflectance, back reflectance, and transmittance. "birch_branch", "dark_soil_mollisol", and 
"birch_leaf_green" are the default spectra in LESS, and should not be changed.

The observation 
zenith angle.

The imaging plane

The observation 
radius.
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 【Terrain】

Parameter Number Explanation

Type PLANE
PLANE: Flat terrain; RASTER: Use ENVI 
raster image as terrain; MESH: Use OBJ file as 
terrain;

XSize 100 Scene Size - Width in meters

Ysize 100 Scene Size - Height in meters

BRDF Type Lambertian Ground has Lambertian reflectance

Optical Property dark_soil_mollisol This list shows all the spectral curves defined in 
the [Optical Database].

 【Objects】
Click the [Define Object] button, and the window shown in the figure below will pop up. Enter 

“tree” on the far left and click [add] to add an object named “tree”. Select the object, click [Import 
OBJ] in the middle window, and select an OBJ file. LESS comes with some OBJ files in the 
installation directory, such as the “BEPE_FROM_HET07_JPS_SUM.obj” file in “… 
\app\Database\3D_Objects\Trees\RAMI”. After import, all groups defined in the OBJ file (defined 
by the “g” in the OBJ file) will be displayed. Select each group separately and set the corresponding 
[Optical Property]. “tree_leaves.obj” spectral property is set to “birch_leaf_green”, and 
“tree_stem_branch.obj” spectral property is set to “birch_branch”.(Figure 26)

Figure 26.  Define a scene Object

 Define positions for scene elements
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Select the object (e.g. “tree”) in the main window and click the [Random] button. In the 
pop-up window, define the minimum distance between any two trees (to avoid trees overlapping 
each other) and click [OK]. The “tree” object will then be randomly distributed in different 
positions in the scene.(Figure 27)

Figure 27.   Define the location of the scene Object

 three-dimensional display

Click the button[ ] on the main interface to display the 3D structure of the scene and check 
if the scene meets the expected goals.(Figure 28)

Figure28.  3D Scene Visualization.

 Image Simulation and Results Viewing:
Click the menu [Run] -> [Run All] to start the simulation. After the simulation is complete, 

click the menu [Tools] -> [Open Results Folder] to open the simulation results directory. The file 
“spectral_VZ=0_VA=180” is the simulated radiance image. ENVI can be used to view this 
multispectral file.(Figure 29)
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Figure 29.Analog images: Red (left) and near infrared (right)

 Generating Reflectance Files
Click the menu [Process]-> [BRF Processing] to convert the radiance image to a reflectance 

image. The result will be "spectralVZ=0VA=180_BRF".

5.1.4 Fisheye camera simulation

 Sensor Parameter Settings.
To set the sensor parameters, select "CircularFisheye" in the [Type] menu. A new set of 

parameters will appear to define the characteristics of the fisheye camera. [FOV] represents the field 
of view of the fisheye camera, and [Fisheye Projection] represents the projection mode of the 
fisheye camera. There are four built-in projection modes in LESS:

 Equisolid: equal area projection
 Orthographic: orthographic projection
 Equidistant: equidistant projection
 Stereographic: stereographic projection

The commonly used projection mode is equisolid projection, which is also known as equal-
area projection.(Figure 30)

Figure30.  Fisheye Camera Parameter Settings.
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After selecting the fisheye camera, the observation mode of the camera has also changed. 
Therefore, it is necessary to reset the relevant parameters in [Observation]. [Camera Position] 
defines the position of the camera, while [Target] defines the observation point of the camera. The 
vector composed of these two points actually defines the observation direction of the camera. If 
[Relative Height] is checked, it means that the height Z of the AB point mentioned above is relative 
to the height above the ground (when there is terrain). In this exercise, A and B can be set to (50, 50, 
0), (50, 50, 1), which means that the camera is observing towards the zenith direction from the center 
of the scene.(Figure 31)

Figure31.  Fisheye Camera Observation Parameter Settings

Setting [NoData Value] to 0 for simulation, the resulting fisheye camera photo at 900nm is 
shown in Figure 32 

(file name "spectral_ox=50_00_oy=50_00_oz=0_00_tx=50_00_ty=50_00_tz=1_00").

Figure32.  Example of Fisheye Camera Photo.

5.1.5 Simulation of Multi-angle Reflectance.   

Although the simulated image can be converted to reflectance, this simulation method can only 
simulate one direction at a time. It is inefficient and inconvenient to simulate multiple angles of 
reflectance simultaneously. Therefore, the multi-angle reflectance simulation method in this 
exercise needs to be used.
 Sensor parameter settings

In the [Type] section, select "Photon Tracing" (Figure 33), which represents photon tracing 
simulation. In this mode, since no image is generated, the image width [Width], height [Height], 
and number of rays [Samples] do not need to be set. However, the [Illumination Resolution] needs 
to be set, which represents the density (spacing) of incident photons. The smaller the value, the 
denser the photons, and the more accurate the results, but the slower the calculation speed. In this 
exercise, it can be set to 0.05.
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On the right side of [Products], check "BRF", which will display the [Number of Directions], 
[Virtual Directions], and [Virtual Detectors]:

 [Number of Directions] represents the number of small surface elements (solid angles) that 
divide the upper hemisphere space. Each element will generate a corresponding reflectance. In 
this exercise, it can be set to 10.

 [Virtual Directions] represents the virtual directions used to calculate the directional 
reflectance factor BRF, expressed in zenith angle and azimuth angle. There are two ways to set 
this: one is "Zenith Angle 1: Azimuth Angle 1; Zenith Angle 2: Azimuth Angle 2", representing 
two virtual directions 11 and 22; the other is "Zenith Angle 1, Zenith Angle 2; Azimuth Angle 
1, Azimuth Angle 2", representing four directions combined in pairs (11, 12, 21, 22). In this 
exercise, it can be set to "45:90;60:90".

 [Virtual Detectors] represents placing a virtual detector with a certain size in a certain 
direction to simulate directional reflectance with a certain field of view effect. This option is 
generally less frequently used and can be left blank.

Figure33.  BRF simulating sensor parameter Settings

 BRF simulation

Click on the menu [Run] -> [Run All] to start the simulation. After the simulation is completed, 
click on the menu [Tools] -> [Open Results Folder] to open the simulation result directory. The 
file "photontracing_0_05_BRF.txt" saves the simulated BRF results (Figure 34). The first column 
is the zenith angle, the second column is the azimuth angle, and starting from the third column, it 
corresponds to the reflectance factor BRF of each band. The first 10 rows of results correspond to 
the BRF of the number of elements set by [Number of Directions], and the last two rows correspond 
to the BRF of the virtual directions set by [Number of Directions]. Generally speaking, BRF 
estimated from virtual directions are more accurate.
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Figure34.  BRF simulation results

 Simulating reflectance
In the result folder, “photontracing_0_05_LESS.txt” saves the reflectance values of the scene, 

which is the integral of the accumulated energy over all elements in the upper hemisphere of the 
space.

Virtual plane

In the [Sensor] menu, there is a [Virtual Plane] option. After checking it, a new 

set of parameters will appear, which can define a virtual plane located at the top of 

the scene with a certain range. When simulating the BRF of the scene, the total 

incident and outgoing energy will be calculated based on the range of the 

quadrilateral formed by the virtual plane (i.e., only photons passing through the 

quadrilateral will be collected). The virtual plane has a plane center position ([X] and 

[Y]) and size ([XSize] and [YSize]), and the default height is the highest point of the 

scene, so the value of [Z] here ("MAX") cannot be modified.

In Photontracing mode, if a virtual plane is not defined, the top plane of the 

scene's bounding box will be used as the default virtual plane.
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In orthographic camera mode, if a virtual plane is not defined, there is no virtual 

plane by default. When a virtual plane is defined, the imaging range is the entire scene 

without a virtual plane, and the imaging range is the scene contained in the virtual 

plane when a virtual plane is present. This virtual plane plays a very important role 

in calculating the reflectivity of the canopy and the gap fraction between directions, 

which can avoid the impact of scene sidewalls.

The imaging range. The imaging range.

The non-virtual plane. The definition of a virtual plane.
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5.1.6 Directional Gap Fraction simulation

The Gap Fraction is generally used to describe the probability of gaps in the vegetation canopy 
in a particular direction. In LESS, it can be obtained by simulating an image and then classifying it, 
but a more accurate way is to use four-component images to calculate the proportion of tree canopy 
gaps.
 Parameter Settings

Select “Orthographic” in [Sensor] -> [Type]; set the number of [spectral bands] to be greater 
than or equal to 5, for example, “630.0:2,690.0:2,750.0:2,810.0:2,870.0:2”; check [Virtual Plane]; 
check the “Four Components Product” on the right side of [Products];

In [Observation], set [View Zenith] and [View Azimuth] to the desired direction, for example, 
0 and 180;

 Four-Component Image Simulation
Click on the menu [Run]-> [Run All] to start the simulation. After the simulation is completed, 

click on the menu [Tools] -> [Open Results Folder] to open the simulation result directory. The 
file “spectral_VZ=0_VA=180_4Components” is the four-component image (Figure 34). This file 
contains a total of five spectral bands:

Band 1 is the four-component category to which each pixel belongs: 
1-illuminated soil; 
2-illuminated leaves; 
3-shaded soil;
4-shaded leaves; 
here, categories are determined based on the component with the largest proportion in the 

pixel.
Band 2 indicates the proportion of illuminated soil in each pixel, with a value between 0 

and 1;
Band 3 indicates the proportion of illuminated leaves in each pixel;
Band 4 indicates the proportion of shaded soil in each pixel;
Band 5 indicates the proportion of shaded leaves in each pixel.

 Calculation of Gap Fraction
Therefore, the formula for calculating the Gap Fraction is mean (b2+b4), which is the sum of 

Band 2 and Band 4, and then averaged over all pixels.
For ease of calculation, LESS provides a Python script “DirectionalGapProb.py”, located in 

the directory “[Installation Path] \LESS\app\Python_script”. The script can be run using the Python 
interpreter provided with LESS, for example: [Installation Path]\LESS\app\bin\python [Installation 
Path]\LESS\app\Python_script\DirectionalGapProb.py -i[LESS output result 
path]\spectral_VZ=0_VA=180_4Components -o [Custom result save path]\gaps.txt. The final result 
is saved in the “gaps.txt” file. If there are multiple output files, the script can be called using wildcard 
characters.

 For example, all files containing “4Components” can be processed simultaneously 
[InstallationPath]\LESS\app\bin\python[InstallationPath]\LESS\app\Python_script\DirectionalGap
Prob.py -i[LESS output result path]\spectral_VZ=_VA=_4Components -o [Custom result save 
path]\gaps.txt.(Figure 35)
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Figure 35.  Four component simulation results

5.1.7 Thermal Infrared Image Simulation

 Parameter Settings
To simulate thermal infrared images, select "Orthographic" in [Sensor], check "Thermal 

Radiation", and set the [spectral bands] to 14um, for example, "14000:1".
In [Optical Databse], a series of component temperatures can be defined. For example, "T300" 

is defined as "300:5", which means that the temperature of scene elements under sunlight is 302.5K, 
and the temperature in the shaded area is 197.5K. Similarly, another set of component temperatures 
"T290" can be defined with the value of "290:8".

At this point, the [Temperature] option will appear under [Terrain], select "T290". Then open 
[Define Objects] under [Object] and set the temperature of "treeleaves.obj" to "T300" and the 
temperature of "treestem_branch.obj" to "T290".

 Image simulation
Click on the menu [Run] -> [Run All] to start the simulation. After the simulation is completed, 

click on the menu [Tools] ->[Open Results Folder] to open the simulation result directory. The file 
"thermalVZ=0VA=180" is the simulated thermal infrared image. Open the image in ENVI, and each 
pixel value represents the directional brightness temperature.(Figure 36)

Figure36.  Thermal Infrared Simulation Results
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5.1.8 Solar Induced Chlorophyll Fluorescence Simulation

Currently, LESS simulates canopy chlorophyll fluorescence in both distinguishable and 
indistinguishable Photosystem I (PSI) and Photosystem II (PSII) modes, considering multiple angles 
and imaging modes, based on FLUSPECT. Users only need to set [Sensor][Products][Chl.F] to a 
value other than "No" and assign a fluorescence optical model to the object emitting fluorescence, 
which is generated by the FLUSPECT model. The remaining operations are similar to simulating 
BRF, allowing the simulation of chlorophyll fluorescence.

After setting [Sensor][Products][Chl.F] to a value other than "No", note that all input 
parameters related to the wavelength (e.g., incoming radiation, proportion of sky scattered light, 
custom spectrum, Land Albedo Map, etc.) must contain a fixed spectrum, as described in section 
2.4.1, the actual simulation band is written in ".less\EFwlinsim.txt ".

LESS includes two built-in versions of FLUSPECT: Fluspect_B_CX_P6 (distinguishing PSI 
and PSII fluorescence) and Fluspect_B_CX_PRO (not distinguishing PSI and PSII fluorescence). 
The former is used when [Sensor][Products][Chl.F] is set to "Split PSI PSII", while the latter is used 
when set to "Combine". The two models handle dry matter content and fluorescence quantum 
efficiency slightly differently. The former does not distinguish dry matter categories but 
distinguishes fluorescence quantum efficiency of PSI and PSII, while the latter can distinguish 
carbon-based and nitrogen-based dry matter but does not distinguish fluorescence quantum 
efficiency of PSI and PSII. It should be noted that the latter can only distinguish dry matter 
categories when the dry matter content is set to 0; otherwise, it does not distinguish. When 
[Sensor][Products][Chl.F] is set to "No", FLUSPECT only generates optical model without 
generating fluorescence materials, which is equivalent to PROSPECT.

Currently, LESS only simulates the radiative transfer process of leaf fluorescence emission in 
the canopy. It cannot accurately depict environmental factors such as light and temperature affecting 
leaf fluorescence yield. Users can approximate the environmental effects by assigning different leaf 
parameters, i.e., different FLUSPECT input parameters, to objects in different groups.

Fluorescence products are stored in the Results directory and are marked with "Fluor". The 
descriptions of various fluorescence products are shown in the table below.

Fluorescent product

Orthographic
or

CircularFisheye、
perspective

*_All_Radiance_with_Flour
Total radiance mixed with fluor
escence, unit: W/(m2·nm·sr)

*_Fluor(PSI/PSII)

Canopy fluorescence yield, with
 the addition of PSI or PSII la
bel if "Split PSI PSII" is chose
n, unit: mW/(m2·nm·sr)

*_All_Radiance_with_Flour_BRF

After clicking the menu [Proces
s] ->[BRF Processing], the proc
essing result of *_All_Radiance
_with_Flour image

PhotonTracing

*_Fluor_All_*.txt->
BRF_with_Fluor*

BRF doped with total fluoresce
nce

*_Fluor_All_*.txt->
Fluor(_PSI/PSII)*

Canopy fluorescence yield, with
 the addition of PSI or PSII la
bel if "Split PSI PSII" is chose
n, unit: mW/(m2·nm·sr)

*_co_sgl.txt

Only photons that interact once 
with leaves or woody elements 
(and not with soil) are consider
ed, i.e. the first canopy scatteri
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ng. Fluorescence is a single em
ission of the leaf

*_mlt.txt
Only photons that interact twic
e with any scatterer in the sce
ne are considered

*_uc_sgl.txt

Only photons that interact once 
with the underlying background 
(i.e., the soil) are considered (a
nd not with any other factors), 
i.e., the soil scatters once, with
out fluorescence

5.1.9 Layered Illumination/Shaded Leaf Area Ratio*1

Layered Illumination/Shaded Leaf Area Ratio refers to the ratio of illuminated/shaded leaf area 
in each horizontal layer of the canopy. The area here refers to the absolute area of the leaves, which 
is different from the ratio of the four components (observation directions) in the four-component 
simulation.(Figure 37)

1 带星号功能为实验功能：实验功能是指目前在 LESS 中已经实现，但是处于测试阶段或者使用人数

较少，为简化程序界面，因此未加入到 GUI 中，可通过手工配置参数开启。
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Figure37.  Layered Illumination/Shaded Leaf Area Ratio
To enable the calculation of layered illumination/shaded leaf area ratio, create a file named 

“sunlit_leaf.conf” under the [Parameters] directory after creating a project and a scene, and select 
the PhotonTracing mode. The file content should be the number of layers separated by a colon, for 
example “0:1:20”, which means that the layers are separated every 1 meter from the altitude of 0 
meters to 20 meters. The parameter that needs to be set is the [Illumination Resolution]. The 
smaller the value, the higher the calculation accuracy. Other products such as BRF and fPAR can be 
left unchecked. After executing the simulation, the “photontracing_*_*_Layer_fSunlitLeaf.txt” file 
will be generated under the [Results] directory, which records the layered illumination/shaded leaf 
area ratio. In the result file, “All Scene Components” represents the illumination/shaded ratio of all 
elements in the scene. The subsequent results are statistics for different scene components, such as 
leaves and branches in the scene. “Total” in the result represents the total illumination/shaded area 
ratio of the canopy, which needs to be noted that the total illumination/shaded ratio of the canopy is 
not a direct average of the ratio of each layer.（Figure 38）

Figure 38.  Layered Illumination/Shaded Leaf Area Ratio calculation interface and results

Case

The example result of the layered illumination/shaded leaf area ratio for a simple scene is 

shown in Figure 39. In this scene, there are two large leaves at a height of 1m and 2m from the 

ground, respectively, and their vertical projections completely overlap.
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Figure 39.  Example Result of Layered Illumination/Shaded Leaf Area Ratio

If the sun is vertically overhead, the calculated results are as follows:

The lower leaves are completely shaded, while the upper leaves receive full illumination, 

resulting in a total canopy illumination ratio of 0.5. If the sun is at an elevation angle of 45° 

and azimuth angle of 90° (east direction), the calculated results would be as follows:

      

5.1.10 Canopy photosynthesis simulation

Based on PAR (Photosynthetically Active Radiation) simulation, the absorbed light energy by 
facet elements or turbid medium can be obtained. Combined with the leaf photosynthesis model 
Farquar, the canopy photosynthesis rate can be estimated. The leaf photosynthesis model aligns 
with the biochemical module in the SCOPE model, which means all parameters that can be exported 
by SCOPE can also be export by LESS.

After creating a new project and setting up a scene, select the PhotonTracing mode. Under 
[Sensor] > [Products] > [Photosynthesis], choose [FvCB]. At this stage, only [Layer Definition] 
is configurable, while other products cannot be simulated. The [Layer Definition] settings follow 
the same configuration method as FPAR simulation. Since PAR band absorption (400–700 nm) is 
simulated, the spectral range must cover this interval. The [Illumination Resolution] should also 
be appropriately refined.

When [FvCB] is selected under [Photosynthesis], the [Ambient] parameter group will appear 
in [Illumination & Atmosphere]. Currently, only oxygen concentration and atmospheric pressure 
are functional parameters. In the [Optical Database], [Temperature Definition] and [Biochemical 
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Definition] will become available. Click these buttons to open interfaces for temperature and 
photosynthetic parameter settings. Parameters are differentiated for sunlit and shaded leaves, with 
input formats consistent with thermal infrared simulations.
Note:

• Do not delete "T300" in [Temperature Definition] or the "-" symbol in [Biochemical 
Definition].

• In photosynthetic parameters:
o el represents leaf boundary layer water vapor pressure.
o Cs represents leaf boundary CO₂ concentration.
o Other parameters align with SCOPE.

Since the leaf photosynthesis model aligns with SCOPE, the calculation of chlorophyll light 
absorption is required. In LESS, when the spectral properties of photosynthetic components are set 
to spectra generated by the Fluspect/PROSPECT models or predefined spectra (e.g., 
birch_leaf_green or larch_leaf_green from the spectral library), the program will automatically 
generate a *_kChlrel.txt file in the [Parameters] folder. This file indicates the chlorophyll light 
absorption ratio per band. For non-compliant spectral inputs, kChlrel defaults to 1.
Assigning Parameters to Components
In [Objects Definition], set temperature and photosynthetic parameters for photosynthetic 
components:

1. Select photosynthetic components in [Components].
2. Assign [Optical Property], [Temperature], and [Biochemical] properties.
3. Non-photosynthetic components must also be assigned [Optical Property], but use "-" 

under [Biochemical] to exclude them from photosynthesis. Non-photosynthetic 
components will automatically adopt the "T300" temperature value (non-editable).

Output Files
Results are stored in the Results folder with the photosynthesis tag.

• Current limitations: Photosynthetic components must be represented either by 
facets or turbid medium (mixed representations are unsupported).

• All files use comma-separated values.
Output Details

1. Facet-based representation:
o *_A.txt: Photosynthesis rate per unit area of sampled facets.
o *_APAR_Chl.txt: Photon flux density per unit area of sampled facets.
o *_S.txt: Area of sampled facets.
o Layer/instance estimates:

 *_A_layer.txt: Estimated total photosynthesis rate per layer.
 *_A_layer_sampled.txt: Sampled total photosynthesis rate per layer.
 *_APAR_Chl_layer.txt: Estimated total photon flux per layer.
 In Layer Definition Mode 1:

 *_A_instance.txt: Estimated total photosynthesis rate per 
component.

 *_A_instance_sampled.txt: Sampled total photosynthesis rate per 
component.

 *_APAR_Chl_instance.txt: Estimated total photon flux per 
component.

 *_APAR_Chl_instance_sampled.txt: Sampled total photon flux 
per component.

2. Turbid medium representation:



LESS Manual

39

o *_A_layer.txt: Total photosynthesis rate per layer.
o *_APAR_Chl_layer.txt: Total photon flux per layer.
o *_A_instance.txt: Total photosynthesis rate per component.
o *_APAR_Chl_instance.txt: Total photon flux per component.

5.1.11 TRAC simulation*

TRAC is a commonly used instrument for measuring Leaf Area Index (LAI), which records 
the direct solar radiation transmittance. The measurement process typically involves selecting 
several sample lines in a plot, and TRAC measures the canopy transmittance at a uniform time 
interval as the observer walks along the line. In LESS, the transmittance at each position on a 
simulated sample line can be calculated at equidistant intervals. The transmittance is determined by 
emitting rays in the direction of the sun, while taking into account the sun's apparent radius (0.25°).

To use TRAC, a configuration file named "trac.conf" should be created in the [Parameters] 
directory. The file content should include the starting point of the sample line (first line), the end 
point of the sample line (second line), the distance interval (third line), and the magnitude of the 
number of rays used to calculate the transmittance at each position along the line (fourth line). It 
should be noted that the number of rays here only represents a magnitude, and if the value is set to 
30, the number of emitted rays will be approximately 900.(Figure 40)

Figure 40.  TRAC simulation examples
After the simulation is completed, the results are saved in the "instrument_trac.txt" file in the 

"Results" directory. The first number in the first row of the file represents the total number of points 
simulated, followed by the number of columns in the results (3 in this case), and the value 
"1.000000" represents the height (z-value) set in the trac.conf file. From the second row onwards, 
the first three columns represent the x-coordinate, y-coordinate, and transmittance value at each 
point.

5.1.12 Fisheye image transmittance simulation*

Fisheye image transmittance refers to simulating a fisheye image where each pixel represents 
the transmittance of light. In the image, a value of 1 represents the transmittance of the sky, a value 
of 0 represents complete pixel obstruction, and values between 0 and 1 represent partially obstructed 
pixels. It should be noted that this simulation also supports the turbid medium mode, where the 
transmittance of the turbid medium is calculated. This mode calculates the transmittance of direct 
sunlight in conjunction with LAD (Leaf Area Density), which is the unit of measure for the turbid 
medium. In the turbid medium mode, the radiative transfer equation is recalculated, and the 
transmittance values differ slightly from those obtained in the clear sky mode. During the fisheye 
image transmittance simulation, the transmission and scattering of light are calculated through three 
sections: the atmosphere, vegetation, and the ground, with transmittance calculated during this 
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transmission process. When simulating at dawn or dusk, the scattering of light near the ground is 
greater, which affects the calculation of transmittance. Additionally, when a ray of light hits a pixel, 
it may be covered by multiple transmission paths, so the weighted average of transmittance needs 

to be considered. that is  (LAD is the leaf area density). 
This simulation is set up exactly as the fisheye camera simulation in section 2.1.2, except that 

you need to create a dtrans.conf file under the Parameters folder to enable this mode, otherwise the 
simulation results are exactly as 5.1.4 (i.e., the simulation gets radiance information for each 
pixel).(Figure 41)

Figure 41.   Examples of image simulation of transmittance of fisheye camera

5.1.13 Light simulation*

In LESS, certain objects can be set as light sources with a certain emission power. Therefore, 
scenes with night-time lighting can be simulated. To use the lighting simulation in LESS, you can 
construct a scene as normal and then create a file named “lights.conf” under the [Parameters] 
directory. The file contains the emission spectra for a component, which can be defined through 
blackbody emission or direct input spectra. For example, “lights.conf” contains two lines, with the 
first line defining the component “light_Disc.obj” in the scene as having a blackbody emission with 
a temperature of 5000K. LESS will automatically calculate the required emission spectra for the 
simulated bands based on the temperature and blackbody emission. The second line defines the 
spectrum using “spectrum,” with the spectral bands needing to match the number of bands defined 
in the sensor, and its units in w/m2/sr/nm. The name of the component can be found in the objects.txt 
file or GUI. By default, optics in LESS only emit from the front-facing side of the surface based on 
the normal vector, which is defined using the right-hand rule. Therefore, attention should be paid to 
the definition of the obj file’s normal vectors during the simulation.(Figure 42)
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Figure 42.  Lighting simulation parameter setting

5.1.14 Re-collision probability simulation

Recollision probability refers to the probability of the photon hitting the canopy again after 
scattering with the canopy, which is the core concept of spectral invariant theory. LESS provides 
parameters that are closely related to spectral invariant theory, such as simulated recollision 
probability, interception rate, hemisphere and directional escape probability. In LESS, the 
simulation of re-collision probability is carried out at the same time as the FPAR simulation, so after 
selecting [PhotonTracing] in [Sensor], it is necessary to check [fPAR & Recollision Prob.] (If 
only the re-collision probability is simulated, Don't worry about the value of the Layer Definition). 
After the simulation, the *._prob. txt file will be generated in the result folder, and the result is 
shown in the figure below, where Total probability represents the total recollision probability of the 
canopy and is the sum of all scattering times. Canopy interception probability represents the total 
interception rate of incident light, that is, the probability that a scattering is intercepted by the canopy. 
Upward/Downward escape probability represents the probability of space escape in the upper and 
lower hemispheres of the canopy. Escape probability is defined as the probability of photon escaping 
from the canopy after scattering with the canopy, and the value is the sum of multiple scattering. 
Recollision probability + upper hemisphere + lower hemisphere escape probability =1. In addition 
to the total probability, the output also provides the number of photons scattered each time, from 
which the probability of the number of scatterings can be calculated or accumulated to get the total 
probability, Scat_order represents the number of scatterings, Tot_photons represents the total 
number of photons scattering from the canopy, Its represents the number of photons colliding with 
the canopy again, and Up_escape/Down_escape represents the number of photons escaping from 
the upper and lower hemispheres.

The upper hemisphere escape probability is further subdivided into the directional escape 
probability, which provides the number of escaped photons in each direction under each scattering 
number, according to which the probability can be calculated (right of the figure below). The 
Escape_photons represent the total number of escaped photons in this solid Angle, where the sum 
of all directions equals the total hemispheres escaped. Number of directions (N) indicates that the 
upper hemisphere space is evenly divided into equal solid Angle directions, the size of each solid 

Angle is  , 
Zenith_Angle/Azimuth_Angle indicates the central direction of each solid Angle, Azimuth_Angle 
is the range clockwise from north [0°,360°]. According to the central direction provided, the 
azimuth range of zenith Angle of each solid Angle can be inversely calculated. For example, as 
shown in the figure below, the upper hemisphere space is divided into 10 directions, and zenith 
Angle and azimuth Angle both start from 0, then 18.43 represents the zenith Angle range of this day 

2𝜋𝜋
𝑁𝑁
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[0, 36.86]. From this we can calculate the next zenith Angle range as [36.86, 63.43+(63.43-
36.86)]=[36.86, 90.00], and so on. The number of directions for the escape probability of the upper 
hemisphere direction can be set in the following way (the default value is 1). In the [Parameters] 
directory, create a file named p_prob.conf with the number of directions in the file, for example, 
"100", then the corresponding number of directions will be displayed in the output file.(Figure 43)

Figure 43.  Re-collision probability simulation

5.1.15 Cloudy medium expressed leaf

In LESS, apart from using triangular surfaces to describe each leaf in detail, a cluster of leaves 
can also be statistically described using turbidity media. The advantage of this method is that it does 
not need detailed information of each leaf, but only needs to set its leaf area density, leaf inclination 
distribution and hot spot factor. The premise of using this expression is to create the outer envelope 
of the tree crown, which can be simple geometry or regular shapes such as volume elements. In 
LESS, the commonly used expression is alphashape, which can create a tight outer envelope based 
on the three-dimensional point cloud or surface element model to simulate the appearance of the 
tree crown, and the parameters of the turbidity medium can be set inside. The outer envelope of the 
tree Crown can be created using LESS [Tools] [Simple Crown Generator] or from an existing 3D 
OBJ model (sheet). LESS provides a tool to create an envelope from the existing OBJ model. In 
order to facilitate batch processing, this tool is provided in the form of Python functions. You can 
directly enter the Python terminal from the icon of the LESS main interface (the right picture in the 
following figure) or [Tools] [Python Console], where you can directly run the code. The function 
for building the outer envelope is:

obj_to_alphashape(obj_path, alpha_value=0.5, out_dir=None, 
keep_groups=None)

obj_path indicates the input obj path. alpha_value represents the radius parameter when 
constructing alphashape. The larger the value, the closer the outer envelope constructed is to the 
convex envelope, and the smaller the value is to the concave envelope. However, if the value is too 
small, it may fail, and the default value is 0.5); out_dir indicates the directory of the output file. If 
this parameter is not set, the output file will be saved to the same directory as the input obj file by 
default. keep_groups indicates that only some groups are calculated, that is, the original input obj 
file may have multiple groups, such as both branches and leaves. Usually, we only need to build the 
outer envelope for leaves, so only leaves can be included here. If this parameter is not set, all 
components are included by default. An example of a typical call is shown below. At the same time 
as the output envelope, a txt file with the same name will be output, which records the surface area 
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of all components, as well as the calculated leaf area density, which can be used as the input of 
LESS.(Figure 44)

Figure 44.  Creation and setting of turbid media crown

5.2 Utility

5.2.1 LAI calculation tool

Click the menu [Tools]-> [LAI Calculator] to open the LAI calculation interface. Rows 
indicates the number of grids in the X direction, Cols indicates the number of grids in the Y direction, 
and Layers indicates the number of grids in the Z direction. For example, the value of [Grid Size] 
is 1x1x1, indicating that an LAI value is calculated for the entire scene. If the value of [Grid Size] 
is 2x2x2, it means that the whole scene will be divided into 2 regions in the X direction, 2 regions 
in the Y direction and 2 regions in the Z direction, and the final result will be 8 LAI values. It should 
be noted that [LAI Calculator] could calculate not only LAI, and the component names to be 
calculated should be checked below. If only leaf components were selected, the result would be LAI. 
If all components are checked, the result is PAI. As shown in the figure, the scene is divided into 8 
blocks and LAI values are calculated respectively. After parameters are set, click [Run]. Open the 
result file LAI.txt. In the first line, "Scene Size" indicates the scene size. The second line "LAI 
Dimension" is the number of grids set for dividing the scene. LAI values start from the third row. 
The arrangement of LAI values corresponds to the spatial position of the block. The first four values 
are the corresponding values when the height is 1.(Figure 45)

Figure 45.  LAI calculation tool
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5.2.2 Batch processing tool

When the same scene needs to be simulated and only a few parameters are changed, for 
example, to study the change of the reflectance of the earth and the sky when the sun zenith Angle 
is increasing in the same scene, using batch processing tools will greatly reduce the amount of work 
required for simulation. Click the menu [Tools] -> [Batch Tool] to open the batch processing 
interface. Enter any name in [Group], select the newly created [Group], find the Parameter to be 
changed in [Parameter] on the left and select it, such as "sun_zenith", click [>>], and add it to 
[Paramter] on the right. After the changed parameter is added, enter a series of values that the 
parameter wants to set. For example, after sun_zenith is added, enter LIST:0/10/20/30/40. (Note that 
LIST is mandatory, and enter commas when the input method is English.) After parameter setting, 
click [Run] to save the file in the pop-up window, and then the program will run automatically. 
Open the results folder and the BRF files with solar zenith angles of 0°, 10°, 20°, 30°, 40° 
are saved in test0 to test4 respectively.(Figure 46)

Figure 46.  Visual batch processing tool

5.2.3 Image and LiDAR waveform viewer

LESS The default image format of simulated production is ENVI format (that is, a pair of files, 
one of which is an hdr header file), which is saved in the Results directory by default. In order to 
view simulated images easily and quickly, LESS provides a multi-band Image Viewer at the location 
of [Tools] [Data Viewer] [Image Viewer], which will open all ENVI files in the Results directory 
by default. You can select one of them. All the bands of the file are listed below, and on the basis of 
the bands, you can select grayscale or RGB composition to display the image .

In order to view LESS simulated Waveform Data more conveniently, LESS also provided a 
waveform Viewer at the location of Tools [Data Viewer][LiDAR Waveform Viewer]. The 
waveform viewer selected 0.txt from the convolved_waveform directory in the Results directory by 
default, or it could switch waveform files by itself. After selecting one, all waveforms in the file 
would be listed. When selecting one, you could click [Show] to display the waveform. At the same 
time, if "Showing by selection" is selected, the waveform will be displayed immediately after a 
waveform is selected, without clicking "Show". This function can quickly browse the 
waveform.(Figure 47)
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Figure47.  Image viewer and waveform viewer

5.2.4 Simple crown generation tool

The graphical interface of LESS provides a tool for creating a Simple Crown in OBJ format, 
[Tools] [3D Object Creation] [Simple Crown Creator] (as shown below). In addition to the four 
simple tree crowns (cube, ellipsoid, cone and cylinder), LESS provides a tree crown described by 
asymmetric Gaussian distribution function, which uses three parameters to control its shape. Lower 
sigma is used to control the shape of the lower part of the tree crown, the smaller the value, the 
flatter the lower part of the tree crown. Upper sigma controls the top Shape of the tree crown, and 
the larger the value, the sharper the crown; Shape factor controls the overall shape of the tree crown, 
and the larger the value, the closer the crown is to the cylinder. If Generate boundary only is checked, 
only the outer outline of the tree crown will be generated. This tree crown model is mainly used to 
express the leaf in cloudy media. After LESS is imported, the leaf area density and leaf inclination 
distribution can be set. If you check the upper [Include branches], in addition to setting the 
parameters of branches, you can also use branches to control Leaf clumping. Leaf clumping factor 
determines the degree of leaf clumping. When it is 1, the leaves are distributed randomly and evenly, 
and when it is close to 0, the leaves are clustered more in branches. Leaf distance factor represents 
the distance between the leaf and the root of the branch. The closer the value is to 1, the more the 
leaf gathers at the tip of the branch.(Figure 48)

Figure48.  Simple crown generation tool
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5.2.5 Reconstruction of 3D scene from airborne point cloud

LESS's graphical user interface provides tools for reconstructing 3D scenes from airborne point 
clouds, including "Tools," "3D Object Creation," and "3D Forest from LiDAR (ALS)," as shown in 
the figure below. LESS provides five methods for representing tree crowns in turbid media: voxel, 
alpha shape, ellipsoid, cylinder, and cone. Voxel divides space into a uniform grid and calculates its 
radiative scattering for each unit. Alpha shape is a lightweight tree crown representation that 
balances accuracy in structure reconstruction and computational efficiency. Ellipsoid, cylinder, and 
cone are more efficient computation methods but have limited precision due to their overly 
simplified models.

This tool offers four methods for creating tree crowns (single-tree segmentation) in alpha shape, 
ellipsoid, cylinder, and cone: watershed algorithm, hexagonal algorithm, and clustering algorithms 
based on canopy height models (CHMs) or points. The watershed algorithm is suitable for sparse 
tree crowns but performs poorly in continuously dense scenes, resulting in some trees being too 
large or too small. LESS's default watershed window size is 4.5m, but users can set it themselves. 
The hexagonal algorithm is suitable for dense and uniform tree crowns, partitioning space into 
hexagons as the basic unit. The Kmeans clustering algorithm is suitable for all types of tree crowns 
and offers two ways of clustering. One is based on 2D CHM image clustering, which is efficient, 
and the other is direct 3D point cloud clustering, which has better results but may be less efficient. 
Additionally, users can set a height threshold to define the range of understory crowns. If the 
"Include Understory" box is checked, this tool will also model the understory. The tool calculates 
plant area density (PAD) for each reconstructed envelope using one of four methods: Pulse tracking, 
which requires the GPS time of point clouds to recover pulses and calculate transmittance to 
ultimately calculate PAD; a point-based method using only 3D coordinates of ground and non-
ground points to calculate transmittance; a constant value for PAD or PAI set for the entire scene, 
with PAD calculated automatically based on tree crown volume.

The distribution of leaf inclination angle has six types: spherical, uniform, planar, vertical, 
inclined, and extreme, with the default in LESS being spherical. The default LESS project file name 
is "simproj01," and the default leaf spectral attribute name is "leafopname01." After setting the 
parameters, click "Create." After completion, a LESS project named "simproj01" will be generated 
under the "Output Directory," which can be opened using either LESS's GUI or SDK. By default, 
all tree crowns' optical attributes are preset to "leafopname01," so after opening the project, users 
need to define the specific reflectance/transmittance values of "leafopname01" in the "Optical 
Databse" before simulation.(Figure 49)
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Figure 49.  Simple crown generation tool

5.2.6 Python code automatic generation tool

At present, LESS has two ways to run, one is by manipulating the GUI, and the other is through 
the Python SDK script to perform simulation. The advantage of the former is that the operation is 
intuitive and simple, and the advantage of the latter is that it is easy to control the simulation process, 
such as adding elements, modifying the spectrum, and then conducting batch simulation. However, 
simulation through SDK first needs to be familiar with the function interface of SDK, which has a 
certain learning cost. In order to reduce the difficulty of using code, LESS provides the ability to 
automatically generate corresponding Python scripts based on GUI parameters. The method of use 
is: First, open the GUI interface, then set the corresponding simulation parameters, click [Tools] 
[Generate Python Code], and select the save path. Then a py script file will be generated, the 
content of which is the script corresponding to the simulation project created by automatically 
generating GUI using Python SDK. If the script is modified to some extent, the parameters can be 
easily modified or batch simulated.

5.3 LESS file format

5.3.1 instance.txt

In the Parameters directory of the simulation project, the instance.txt file stores the position 
information of each object. The file has three different formats, representing different meanings:

 5-column mode: object_name X Y Z Rotate, where the 5 columns respectively represent the 
object's name, its XYZ position, and a rotation angle. The default rotation angle is 
counterclockwise in the horizontal plane, in degrees.
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 8-column mode: objectname X Y Z Rotate AxisX AxisY AxisZ, with three additional columns 
representing the rotation center axis when rotating. The right-hand rotation rule is adopted, and 
the rotation center is the origin of the obj file. The rotation is performed first before moving to 
the XYZ position.

 11-column mode: objectname X Y Z Rotate AxisX AxisY AxisZ Scale_X ScaleY ScaleZ, 
which includes three additional columns defining the object's size (not scaling factor) in the 
order of scaling, rotation, and translation.

To simplify the GUI interface, LESS only provides direct editing for the 5-column mode. Other 
modes can be edited directly in the instance.txt file and then the project needs to be reopened; 
alternatively, the instance.txt file can be imported from the GUI interface. All coordinate definitions 
in the file are the same as in the GUI, that is, X moves to the right, Y moves downward, and Z is the 
vertical direction. In addition, for each selected position information in LESS's GUI, clicking the 
"Extra Info…" button brings up a dialog box where additional information beyond the 5 columns 
can be edited.(Figure 50)

Figure 50.  Simple crown generation tool

5.4 SDK for Python

5.4.1 Implement LESS simulation using SDK for Python

In addition to using the GUI program for simulation, LESS also provides a Python SDK that 
enables users to create new simulation projects, develop 3D scenes, modify simulation parameters, 
and conduct data simulations using Python scripts. The SDK is located in the pyLessSDK folder of 
the LESS installation directory (e.g., D:\LESS\app\Python_script\pyLessSDK). The main classes 
and their relations in the SDK are shown in Figure 51.
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Figure 51.  LESS Main classes in the SDK and their relationships

 To use the LESS SDK, an appropriate Python interpreter is required. The LESS installation 
package includes a full Python 3.10 interpreter (other Python interpreters can also be used) located 
at "LESS installation directory\app\bin\python\python.exe". It is recommended to use the PyCharm 
Integrated Development Environment (IDE) for code completion and program debugging.

After creating a new project (e.g., PyLessTest), select the appropriate Python version in [File] 
[Settings] [Project Interpreter], as shown in Figure 52. Then create a new .py file to start writing 
the program. To enable the program to find the LESS SDK, there are two ways, first by adding the 
path through the sys module:
import sys
sys.path.append(r"D:\LESS\app\Python_script\pyLessSDK")
from SimulationHelper import SimulationHelper

Although this method allows the program to run, it is not conducive to program development, 
as there is no code hinting. In PyCharm, there is another way, as shown in Figure 52. Click the 
dropdown arrow at [File] [Settings] [Project Interpreter], select [Show All], and then choose the 
Python version being used. Add the location of the LESS SDK to the path, and the module can be 
imported directly.

Figure 52.  PyCharm configuration
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Figure 52.  Configure the LESS SDK in PyCharm

 Ex01 Basic simulation

The following code demonstrates an example of creating a default simulation project using 
Python and conducting simulation directly. Firstly, import the SimulationHelper and Simulation 
classes; the former is an auxiliary class for a simulation project, and the latter represents the entire 
simulation project. Simulation includes a SimulationHelper and a Scene member variable. The 
SimulatinHelper mainly provides functions such as creating a new simulation project and obtaining 
some system parameters (such as the path of Python). For instance, the createnewsim function 
creates a new simulation project based on the input directory path and initializes the project with a 
standard template, setting default parameters, etc. If the simulation project already exists, it will be 
skipped. The Simulation instance is initialized from a simulation project path and a SimulatinHelper 
instance. After obtaining the Simulation instance (i.e., sim), readsimproject function reads the 
simulation project's content into the sim object. Then, the savesimproject() function can be called to 
save the project (no parameters are modified here, so it can also be omitted), and finally, the start() 
function is called to conduct simulation.

# coding: utf-8

from SimulationHelper import SimulationHelper
from Simulation import Simulation
from PostProcessing import PostProcessing
import os
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sim_dir = r"D:\LESS\simulations\Ex01"
sim_helper = SimulationHelper(r"D:\LESS")  # Create a 
SimulationHelper instance with the root directory of LESS 
installation as the parameter

sim_helper.create_new_sim(sim_dir) # Create a new simulation 
project

sim = Simulation(sim_dir, sim_helper)  # Initialize the Simulation 
object

sim.read_sim_project()  # Read the contents of the simulation 
project

sim.save_sim_project()  # Save the project

sim.start()  # Start the simulation

The above code is the simplest simulation process, which can be implemented without opening 
the GUI program. The final simulation result is an image (spectralVZ=0VA=180), which is saved 
in D:\LESS\simulations\Ex01\Results\ directory in ENVI format, with Radiance as the pixel value 
type.(Figure 53)

Figure 53.  The radiance image is obtained by simulation

To convert radiance to reflectance, the radiance2brf function in PostProcessing can be used. 
This function has three parameters, the first being the path of the simulation project, used to obtain 
information such as irradiance. The second parameter is the input file path, which is the radiance 
file obtained from the previous step of the simulation. The third parameter is the output file path - 
the BRF file. After the simulation is completed, the resulting BRF file can be obtained (the 
highlighted and bolded code in the code below is the newly added code).

# coding: utf-8

from SimulationHelper import SimulationHelper
from Simulation import Simulation
from PostProcessing import PostProcessing
import os

sim_dir = r"D:\LESS\simulations\Ex01"
sim_helper = SimulationHelper(r"D:\LESS")  # Create a 
SimulationHelper instance with the root directory of LESS 
installation as the parameter

sim_helper.create_new_sim(sim_dir) # Create a new simulation 
project

sim = Simulation(sim_dir, sim_helper) # Initialize the Simulation 
object
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sim.read_sim_project()  # Read the contents of the simulation 
project

# Output file from the simulation

sim.save_sim_project()  # Save the project

sim.start() # Start the simulation

PostProcessing.radiance2brf(sim.get_sim_dir(), sim.get_dist_file(), 
sim.get_dist_file()+"_BRF")

After the simulation is complete, the resulting BRF file will be displayed as shown in Figure 
54.

Figure 54.  The reflectivity image is obtained by simulation

The code above uses the default output file name spectral_VZ=0_VA=180 (obtained through 
the function sim.get_dist_file). However, in reality, for convenience, we can set our own output file 
name during the simulation by modifying the parameters between read_sim_project and 
save_sim_project, as shown in the following code:

sim.read_sim_project()  # Read the contents of the simulation project

sim.set_dist_file(os.path.join(sim.get_sim_dir(), "Results", 
"output_radiance_file"))

# Output file from the simulation

sim.save_sim_project()  # Save the project

 Ex02 Add scene elements

In Ex01, although we have implemented the entire simulation process, the default scene only 
contains a simple flat terrain of 100m * 100m. In this example, we will add some trees to the scene 
and set their spectra.

A. Importing Scene OBJ Files

In LESS, all scene elements (trees, houses, etc.) are input as OBJ format files consisting of 
triangular faces, and tree models can be generated using third-party software such as 
OnyxTree.(Figure 55)

All scene elements are managed within the Scene class. After creating a Simulation, you can 
obtain an instance of Scene through sim.get_scene() and then access or modify the elements in the 
scene. The example code is as follows:
# coding: utf-8

from SimulationHelper import SimulationHelper
from Simulation import Simulation
from PostProcessing import PostProcessing
import os
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from SceneObjects import SceneObject
from Utility import OBJHelper
import random

sim_dir = r"D:\LESS\simulations\Ex02"

sim_helper = SimulationHelper(r"D:\LESS")  # Create a SimulationHelper, 
the parameter is the root directory of the LESS installation.

sim_helper.create_new_sim(sim_dir)  # Create a new simulation project

sim = Simulation(sim_dir, sim_helper)  # Initialize a Simulation object

sim.read_sim_project()  # Read the content of the simulation project

sim.set_dist_file(os.path.join(sim.get_sim_dir(), "Results", 
"output_radiance_file"))

#################Add scene elements start ####################

scene = sim.get_scene()  # Get the Scene

landscape = scene.get_landscape()  # Get the LandScapeobject

landscape.clear_landscape_elements()  # # Clear the scene elements that 
already exist in the project (must be executed when the program is run 
repeatedly)

obj_tree01 = SceneObject("Tree01")  # Define a scene object named Tree01

# Add an obj file as a component of tree1. For obj files that contain multiple 
groups, the paths for each group must be separated and imported separately, and 
each group must be given a different optical property

comp_list = 
OBJHelper.seperate_obj(r"D:\LESS\app\Database\3D_Objects\Trees\RAMI
\FREX_FROM_HET09_JBS_SUM.obj")
# FREX_FROM_HET09_JBS_SUM.obj contains two components, the first 
one is leaves, and the second one is branch, so they are imported 
separately and given different optical properties.

# birch_leaf_green and birch_branch are default built-in optical 
properties. Custom optical properties will be explained in the next 
example.

obj_tree01.add_component_from_file(comp_list[0], 
"birch_leaf_green")
obj_tree01.add_component_from_file(comp_list[1], "birch_branch")
landscape.add_object(obj_tree01)

# When an obj file is defined, it also needs to be placed in different 
positions, which is called an instance in LESS

# Randomly place in the scene, the default size of the scene is 100m * 100m.

for i in range(1000):
    x = random.random()*100

    y = random.random()*100

    landscape.place_object("Tree01", x=x, y=y)

############### Add scene elements end ##############

# Output file of the simulation

sim.save_sim_project()  # Save the project

sim.start()  # Start the simulation
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PostProcessing.radiance2brf(sim.get_sim_dir(), sim.get_dist_file(), 
sim.get_dist_file()+"_BRF")

Figure 55.  Add a tree model to the scene

B. Custom Optical Properties

In LESS, an optical property typically refers to a pair of reflectance and transmittance for both 
the front and back sides of an object (assuming the transmittance is the same for both sides). The 
class for defining optical properties is called OpticalItem. Based on the example above, the code 
that needs to be modified is:

scene = sim.get_scene()  # Get Scene

landscape = scene.get_landscape()  # Get Landscape object

landscape.clear_landscape_elements()  # # Clear existing landscape 
elements in the project (must be executed when running the program repeatedly)

# Define an optical property (front reflectance; back reflectance; 
transmittance)

landscape.clear_user_defined_optical_properties()  # Clear user-
defined optical properties

# LESS initially has two bands

op_item01 = OpticalItem("op_leaves", "0.05,0.4;0.05,0.4;0.05,0.4")  
landscape.add_op_item(op_item01)  # Add to the scene library
op_item02 = OpticalItem("op_branch", "0.2,0.45;0,0;0,0") #LESS 
initially has two bands

landscape.add_op_item(op_item02)  # Add to the scene library

obj_tree01 = SceneObject("Tree01")  # Define a scene object called Tree01

# Add an obj file as a component of tree1. For obj files containing multiple 
groups, each group needs to be separated and imported separately with different 
optical properties set for each group

# different optical properties set for each group

comp_list = 
OBJHelper.seperate_obj(r"D:\LESS\app\Database\3D_Objects\Trees\RAMI
\FREX_FROM_HET09_JBS_SUM.obj")
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# FREX_FROM_HET09_JBS_SUM.obj contains two components, the first 
one is leaves and the second one is branch, so they are imported 
separately

# birch_leaf_green and birch_branch are default pre-defined 
internal optical properties, custom optical properties will be 
explained in the next example

obj_tree01.add_component_from_file(comp_list[0], "op_leaves")
obj_tree01.add_component_from_file(comp_list[1], "op_branch")
landscape.add_object(obj_tree01)

C. Custom Sensor

In examples Ex02-A and Ex02-B, we used the default sensor, which is an orthographic 
projection with an image size of 100 pixels by 100 pixels. In this example, we will modify the sensor 
parameters using the SDK. The sample code is as follows:

from Observation import ObservationOrthographic
…

# After defining an obj file, it needs to be placed at different locations, 
which is called an instance in LESS

# Randomly place the object in the scene, the default scene size is 100m*100m

for i in range(1000):
    x = random.random()*100

    y = random.random()*100

    landscape.place_object("Tree01", x=x, y=y)

################ Adding Landscape Elements end #####################

# Modify sensor parameters

sensor = scene.get_sensor()  # Get Sensor first

sensor.set_film_type("rgb")  # Set to rgb, which can directly output a png 
image. If set to spectrum, it outputs a multi-band image in Envi format.

sensor.set_image_width(300)
sensor.set_image_height(300)
sensor.set_sample_per_pixel(16)

# Create a new Observation, then set it to the scene. It can also be read 
directly and then modified.

obs = ObservationOrthographic()  # Default zenith angle is 0 and azimuth 
angle is 180

scene.set_observation(obs)

# The output file for simulation

sim.save_sim_project()  # Save project

sim.start()  # Start simulation

Using the above code to simulate an image, as shown in Figure 56, it can be seen that the 
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resolution of the simulated image has increased and the outline of the tree canopy is clearer.

Figure 56.  Modifying Sensor parameters

The previous modifications only adjusted the parameters of the default SensorOrthographic 
(e.g. image size). If other types of sensors need to be set (SensorPerspective, SensorFisheye, 
SensorPhotonTracing), they need to be created and added to the scene. An example code for 
SensorPerspective is shown below:

# Add a new sensor

sensor = SensorPerspective()

sensor.set_fov_x(40)  # X direction field of view (unit: degree)

sensor.set_fov_y(30)  # Y direction field of view (unit: degree)

sensor.set_film_type("rgb")
sensor.set_image_width(300)

sensor.set_image_height(300)

sensor.set_sample_per_pixel(16)

scene.set_sensor(sensor)

# Add a new observation, which corresponds to ObservationPerspective for 
SensorPerspective

obs = ObservationPerspective()

obs.set_origin((50, 50, 150))  # Set the position of the camera

obs.set_target((50, 50, 0))  # Set the observation target of the camera. 
The vector between the target and the origin determines the direction of the 
camera observation.

scene.set_observation(obs)

SensorPhotonTracing simulates forward ray tracing and does not have an actual camera entity. 
Therefore, ObservationPhotonTracing corresponding to SensorPhotonTracing does not need to set 
specific parameters, and an empty instance needs to be created. Example code is shown below:

# Add a forward ray tracing sensor to simulate multi-angle reflectivity

sensor = SensorPhotonTracing()

sensor.enable_brf_product(True)
sensor.set_sun_ray_resolution(5)

sensor.set_virtual_directions("10:90;20:90")
scene.set_sensor(sensor)
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obs = ObservationPhotonTracing()

scene.set_observation(obs)

 Ex03 Lidar simulation

Simulation of LiDAR is similar to that of image simulation, but there are differences in the 
parameters of the sensor. To enable LiDAR simulation, call scene.enable_lidar(True). Currently, 
there are two built-in LiDAR sensors, ALSLiDAR and TLSLiDAR. Each sensor has three types of 
parameters: Beam, Device and Platform. Beam includes Axial Division and Maximum Scattering 
Order, which are called using liarSensor.beam.axialDivision and lidarSensor.beam.maxOrder 
(lidarSensor being the created LiDAR object, for example, lidarSensor = ALSLiDAR()). Device is 
the hardware parameter of the instrument, which includes spot energy, etc., called using 
lidarSensor.device(). Platform is the platform parameter, called using lidarSensor.platform. The 
function liarSensor.set_lidar_sim_mode(LiDARSimMode.MultiRayPointCloud) sets the 
simulation mode, there are three types: Single Ray Point Cloud, Multi Ray Point Cloud, and Multi 
Ray Waveform (corresponding to GUI one by one). After creating the sensor, it needs to be set to 
the scene using scene.set_lidar_sensor(liarSensor), and then save the project and run the simulation.

# coding: utf-8

from SimulationHelper import SimulationHelper

from Simulation import Simulation

import os

from LiDAR import LiDAR, ALSLiDAR, LiDARSimMode

sim_dir = r"D:\LESS\simulations\Ex03_lidar"

sim_helper = SimulationHelper(r"D:\LESS")  # Create a SimulationHelper 
with the installation root directory of LESS

sim_helper.create_new_sim(sim_dir)  # New construction simulation project

sim = Simulation(sim_dir, sim_helper)  # Initialize the Simulation object

sim.read_sim_project()  # Read the contents of the simulation project

scene = sim.get_scene()  # Get Scene

scene.enable_lidar(True)
liarSensor = ALSLiDAR()

liarSensor.beam.axialDivision = 30

liarSensor.beam.maxOrder = 1

liarSensor.platform.altitude = 800

liarSensor.platform.startX = 5

liarSensor.platform.startY = 50

liarSensor.platform.endX = 95

liarSensor.platform.endY = 50

liarSensor.platform.swathWidth = 90

liarSensor.platform.rangeResolution = 0.5

liarSensor.platform.yawResolution = 0.5

liarSensor.platform.minRange = 770

liarSensor.platform.maxRange = 805

liarSensor.set_lidar_sim_mode(LiDARSimMode.MultiRayPointCloud)
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scene.set_lidar_sensor(liarSensor)

sim.save_sim_project()  # Save the project

sim.start()  # Start simulation

5.4.2 Crown formation

The SDK for Python provides a set of tools for generating tree crowns of various shapes (with 
randomly distributed leaves inside the crown). The fundamental parameters of the tree crown are 
shown in the figure below.(Figure 57)

Figure57.  Basic parameters of tree crown

Here is the code sample:

from ObjectGenerator import CrownGenerator, CrownShape, LeafShape, LAD
cg = CrownGenerator()
cg.lvd = 10000  # Leaf Area Index, LAI
cg.crown_diameter_EW = 2  # East-west crown
cg.crown_diameter_SN = 2  # North-south crown width
cg.crown_height = 4    # Crown height
cg.crown_shape = CrownShape.ELLIPSOID    # Crown shape
cg.leaf_angle_dist = LAD.SPHERICAL    # leaf angle distribution
cg.single_leaf_area = 0.001     # Individual blade area
cg.leaf_shape = LeafShape.SQUARE    # Blade shape. If DISK is set, the number of triangles on 
the blade can be set（leaf_number_triangles）
cg.has_trunk = True  # Include trunk or not
cg.trunk_height = 3  # If yes, set the trunk height
cg.dbh = 0.2 # Main DBH
cg.generate_crown(r"D:\crown.obj")  # Save the obj file



LESS Manual

59

6. LESS extension modules

6.1 LESS1D
The canopy radiation transfer model is the foundation for vegetation quantitative remote 

sensing inversion. The current commonly used one-dimensional model is widely applied due to its 
high computational efficiency. Although three-dimensional models can obtain more accurate 
simulation results, the complexity of input parameters and less convenient operations limit their 
application. To fully utilize the accuracy feature of the three-dimensional model, this study 
developed the LESS1D module by compromising between one and three dimensions, which is a 
one-dimensional simplified version of the LESS three-dimensional radiation transfer model. 
LESS1D provides input parameters similar to a one-dimensional model (such as leaf area index, 
leaf inclination angle distribution, and plant density), but with the calculation accuracy of a three-
dimensional model (no need for approximate processing of hotspots). The LESS1D currently 
provides three scene simulations: LESS-Hom, LESS-Row, and LESS-Forest, which represent 
horizontally uniform distribution scenes, ridge row structure scenes, and discrete forest canopy 
scenes, respectively. The radiation transfer calculation process of LESS1D is consistent with the 
LESS model, which performs radiation transfer process entirely by ray tracing, therefore, it has high 
computational accuracy. LESS1D provides a user-friendly graphical interface that supports batch 
input of parameters and batch simulation, making it an ideal tool for simulating a large number of 
parameter combinations.

To open the LESS main program, open the LESS1D main interface under [Tools], click 
[Browse] to select the simulation result output path, and create a new simulation project. You can 
also load an existing simulation project through the main interface by selecting [Tools] and then 
[Load]. After setting all the parameters, click [Tools] and then [Save] to save the simulation 
parameters.

1.Basic parameter settings: In [General] set the spectral [wavelengths] for simulation, and 
set the number of cores according to the computer's performance in [num_of_cores].

2.Leaf reflectance simulation: For convenience, LESS1D provides an additional PROSPECT 
model that can simulate leaf scale reflectance and transmittance by inputting leaf parameters. The 
data type of each parameter has two options, [LIST] and [RANGE], with [LIST] separating 
different data with a "/," and [RANGE] setting the lower limit, step size, and upper limit. The final 
simulation result is the combination of each parameter, making it easy to perform batch processing. 
In [Prospect5D],  set the leaf parameters, click [Browse] to set the output directory, and click [Run] 
to obtain the leaf spectral reflectance and transmittance simulation.

3.Canopy spectral simulation: LESS1D provides three canopy scenarios, LESS-Hom, LESS-
Row, and LESS-Forest, which represent horizontally uniform distribution scenes, ridge row 
structure scenes, and discrete forest canopy scenes, respectively.(Figure 58)
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Figure 58.  LESS1D Main interface and tree crown parameters

(1). Horizontal homogeneous scene 【LESS-Hom】

Parameters Description

lai The LAI value of the scene in LESS-Hom.

lad The leaf angle distribution type: Erectophile vertical type, 

Exemophile extreme type, Plagiophile slanted type, 

Planophile plane type; Spherical spherical type, Uniform 

uniform type.

hotspot The hot spot calculation formula is the ratio of leaf length to 

canopy height.

leaf_op Leaf spectrum. When “use_prospect” is checked, LESS1D 

will automatically calculate the leaf spectral parameters 

based on the “prospect” parameter.

soil_op Soil spectrum (the number of bands needs to be consistent 

with vegetation, etc.).

sky_per Sky light proportion (the number of bands needs to be 

consistent with soil and vegetation, etc.).

sza/saa，vza/vaa The solar zenith angle/azimuth angle, the viewing zenith 

angle/azimuth angle.
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(2). Ridge row structure scene 【LESS-Row】

(3). Ridge row structure scene 【LESS-Forest】

4.【Advanced】settings
If [has_fpar] is not checked, the simulation results will only output BRF values; if [has_fpar] 

is checked, the simulation results will output both BRF and FPAR values.
In the [fpar_layers] setting, the scene is divided into layers to obtain the fPAR of each layer. 

The format is “starting height: step length: ending height”.
In the [sun_spec] and [sky_spec] fields, the direct and scattered radiation values of the scene 

are entered, respectively.

5.Simulation results
After setting the parameters, set the storage and output path in [Browse], click [Run] in the 

lower-left corner of the simulated scene page to start the simulation, and view the results in the 
[Result] path after the simulation is complete.

(1) BRF results
Open the [less_BRF_info] txt file in [Result] to view the input parameters. The BRF 

simulation results are stored in the [less_BRF] txt file. In this exercise, three bands (600nm, 700nm, 
800nm) are set, and the observation angle range is “-75:2:75”. The BRF values of each band at 

Parameters Description

row_width Ridge width

plant_height Ridge height

ridge_spacing Ridge spacing

Parameters Description

lai_single_tree The LAI of LESS-Forest is the single tree LAI value.

crown_shape Crown shape: Ellipsoid, Cylinder, Corn, Cube.

stem_density The number of trees in the scene, i.e., tree density. (Scene 

area is 100*100m)

tree_height Tree height

crown_diameter Crown diameter

crown_length Crown length

dbh Diameter breast height
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different observation angles can be obtained from the graph.

(2) FPAR results
Open the [less_FPAR] txt file in [Result] to view the FPAR simulation results.(Figure 59)

   

Figure 59.  LESS1D simulation results

Simulation results Description

TfPAR Total FPAR value of the scene, including total leaf FPAR 

and total soil FPAR.

Unnamed
（component name）

Total leaf FPAR

terrain Total soil absorption

Total Absorption FPAR value of each band in the scene

Absorption of 

unnamed/terrain

FPAR value of each band for leaves/soil.
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